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          Adobe Acrobat Reader  
 

Finding Words 
 

You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 

including text in form fields. 
 

To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 

2. Enter the text to find in the text box. 

3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 

the box.  For example, if you search for the word stick, the words tick and sticky will 

not be highlighted. 

 

Match Case finds only words that contain exactly the same capitalization you enter in 

the box. 

 

Find Backwards starts the search from the current page and goes backwards through 

the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 

        

To find the next occurrence of the word, Do one of the following: 

            

            Choose Edit > Find Again  

            Reopen the find dialog box, and click Find Again.  

            (The word must already be in the Find text box.) 

 

Copying and pasting text and graphics to another application 
 

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 

document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 

can switch to another application and paste it into another document.   

 

Note:  If a font copied from a PDF document is not available on the system displaying the 

copied text, the font cannot be preserved.  A default font  is substituted. 
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To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 

       To select a line of text, select the first letter of the sentence or phrase and drag to 

       the last letter.   

 

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 

(Mac OS) as you drag across the width of the document.  

        

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 

(Mac OS) as you drag the length of the document. 

         

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 

on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 

in the document is selected.  When you release the mouse button, the selected text is 

highlighted.  To deselect the text and start over, click anywhere outside the selected text.   

The Select All command will not select all the text in the document.  A workaround for this 

(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 

text to the clipboard. 

 

2. To view the text, choose Window > Show Clipboard 

 

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 

Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 

Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 

Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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ASSOCIATION OF BAY AREA GOVERNMENTS 1 

REGIONAL PLANNING COMMITTEE 2 

THURSDAY, JULY 16, 2020, 1:00 PM 3 

 4 

KAREN MITCHOFF, CHAIR: GOOD AFTERNOON. THIS IS THE JULY 2020 5 

ABAG REGIONAL PLANNING COMMITTEE MEETING. WE DON'T YET HAVE A 6 

QUORUM. BUT I AM GOING TO BRING THE MEETING TO ORDER BY 7 

ANNOUNCING TODAY JULY 16TH, 2020. AGENDA SAYS JULY 1ST THAT 8 

WAS THE INTENT. IN LIGHT OF GOVERNOR NEWSOM'S STATE OF 9 

EMERGENCY DECLARATION REGARDING THE COVID-19 OUTBREAK AND IN 10 

ACCORDANCE WITH EXECUTIVE ORDER N-29-20 ISSUED BY GOVERNOR 11 

NEWSOM ON MARCH 17, 2020 AND THE GUIDANCE FOR GATHERINGS 12 

ISSUED BY THE CALIFORNIA DEPARTMENT OF PUBLIC HEALTH, THE 13 

MEETING WILL BE CONDUCTED VIA WEBCAST, TELECONFERENCE, AND 14 

ZOOM FOR COMMITTEE, COMMISSION, OR BOARD MEMBERS WHO WILL 15 

PARTICIPATE IN THE MEETING FROM INDIVIDUAL REMOTE LOCATIONS. 16 

THE AGENDA IS POSTED. COMMITTEE MEMBERS, YOU ARE WELL VERSED 17 

ON ZOOM PLEASE USE THE RAISED HAND. AND MEMBERS OF THE PUBLIC 18 

IF YOU WISH TO SPEAK USE THE RAISED HAND OR IF YOU ARE DIALING 19 

IN DIAL STAR NINE, AND MR. CASTRO AND I WILL MANAGE YOUR 20 

PUBLIC COMMENTS. WITH THAT M CASTRO WOULD YOU CALL THE ROLL, 21 

PLEASE?  22 

 23 

CLERK OF THE BOARD: YES, MA'AM. I'M CHECKING OUR COMMITTEE 24 

MEMBER LIST. NOW I'LL CONDUCT A ROLL CALL FOR THE REGIONAL 25 
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PLANNING COMMITTEE. COUNCILMEMBER ADAMS? ABSENT. MAYOR 1 

ARREGUIN?  2 

 3 

JESSE ARREGUIN: PRESENT.  4 

 5 

CLERK OF THE BOARD: MAYOR EZZY ASHCRAFT?  6 

 7 

SPEAKER: PRESENT.  8 

 9 

CLERK OF THE BOARD: RICK B?  10 

 11 

RICK BONILLA: PRESENT.  12 

 13 

CLERK OF THE BOARD: MR. CAMPOS? IS ABSENT. SUPERVISOR CANEPA?  14 

 15 

DIR. DAVID CANEPA: HERE.  16 

 17 

CLERK OF THE BOARD: MS. KATHLEEN CHA?  18 

 19 

KATHLEEN CHA: HERE.  20 

 21 

CLERK OF THE BOARD: SUPERVISOR CHAVEZ?  22 

 23 

CINDY CHAVEZ: HERE.  24 

 25 
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CLERK OF THE BOARD: SUPERVISOR DIANE DILLON? IS ABSENT. MAYOR 1 

PRO TEMPORE EKLUND? MAYOR EKLUND, YOU ARE MUTED, BUT I SEE YOU 2 

THERE. COUNCILMEMBER NEYSA FILGOR?  3 

 4 

NEYSA FILGOR: HERE.  5 

 6 

CLERK OF THE BOARD: SUPERVISOR SCOTT HAGGERTY? ABSENT. 7 

SUPERVISOR HANCOCK?  8 

 9 

SPEAKER: HERE.  10 

 11 

CLERK OF THE BOARD: SUPERVISOR NATHAN MILEY IS ABSENT. 12 

SUPERVISOR MITCHOFF?  13 

 14 

KAREN MITCHOFF: HERE.  15 

 16 

CLERK OF THE BOARD: MAYOR PIERCE?  17 

 18 

JULIE PIERCE: HERE.  19 

 20 

CLERK OF THE BOARD: SUPERVISOR RABBIT? SUPERVISOR RAMOS IS 21 

ABSENT. MR. MATT REGAN IS ABSENT. SUPERVISOR KATIE RICE IS 22 

ABSENT. SUPERVISOR CARLOS ROMERO?  23 

 24 

CARLOS ROMERO: PRESENT.  25 
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 1 

CLERK OF THE BOARD: MARK ROSS?  2 

 3 

DIR. MARK ROSS: PRESENT.  4 

 5 

CLERK OF THE BOARD: MR. GREG SCHARFF IS ABSENT. COUNCILMEMBER 6 

SCOTT SEDGLEY?  7 

 8 

SCOTT SEDGLEY: HERE.  9 

 10 

CLERK OF THE BOARD: SUPERVISOR SPERING?  11 

 12 

JAMES P. SPERING: PRESENT.  13 

 14 

CLERK OF THE BOARD: MS. SONJA TRAUSS?  15 

 16 

SPEAKER: I AM PRESENT.  17 

 18 

CLERK OF THE BOARD: MAYOR LORI WILSON?  19 

 20 

LORI WILSON: PRESENT.  21 

 22 

CLERK OF THE BOARD: QUORUM IS PRESENT.  23 

 24 
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SPEAKER: FRED, THIS IS SUPERVISOR BROWN. I DON'T KNOW IF YOU 1 

CALL MY NAME BUT I'M HERE.  2 

 3 

CLERK OF THE BOARD: GOT YOU. SUPERVISOR MITCHOFF, THIS IS 4 

FRED, QUORUM IS PRESENT.  5 

 6 

KAREN MITCHOFF, CHAIR: GREAT WE DO HAVE A QUORUM. WE'LL GO IN 7 

THE ORDER OF AGENDA. FIRST ITEM TWO, CALLING FOR PUBLIC 8 

COMMENT. FOR ANY MEMBER OF THE AUDIENCE WHO WOULD LIKE TO 9 

SPEAK UNDER PUBLIC COMMENT ON ANY ITEM NOT ON THE AGENDA. I 10 

SEE A HIGHLIGHTED NUMBER 415883 CALLER, DID YOU --  11 

 12 

PAT ECKLUND: KAREN, THAT'S ME PAT EKLUND.  13 

 14 

KAREN MITCHOFF, CHAIR: OKAY GOOD. HI PAT.  15 

 16 

PAT ECKLUND: YEAH. I HAVE TO DO BY PHONE AND BY VIDEO.  17 

 18 

KAREN MITCHOFF, CHAIR: OKAY THAT'S FINE. THERE IS YOUR NAME. 19 

OKAY GREAT. FRED, I DON'T SEE ANYONE, DO I HAVE ANY PUBLIC 20 

COMMENTS OR DID ANYONE SEND ANYTHING IN PRIOR TO OUR MEETING.  21 

 22 

CLERK OF THE BOARD: NO SUBMITTED COMMENTS BY E-MAIL AND I SEE 23 

NO ATTENDEES WITH RAISED HANDS FOR THIS ITEM.  24 

 25 
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KAREN MITCHOFF, CHAIR: MOVING TO ITEM THREE WHICH IS THE 1 

CHAIR'S REPORT. THIS IS TO DISCUSS AND TAKEN ACTION ON 2 

CONCLUDING THE REGIONAL PLANNING COMMITTEE SUBCOMMITTEE. AS 3 

MANY OF YOU MAY RECALL SEVERAL YEARS AGO, THERE WERE THREE 4 

SUBCOMMITTEES PUT TOGETHER ON A VARIETY OF ISSUES, ONE OF 5 

WHICH WAS A HOUSING SUBCOMMITTEE. AND NOW AS WE'RE MOVING 6 

FORWARD, AND THE CONCEPT OF CREATING A HOUSING COMMITTEE 7 

STANDING ON ITS OWN, WHICH IS ACTUALLY MEETING RIGHT AFTER 8 

THIS, IT SEEMED APPROPRIATE THAT WE NOT HAVE TWO COMMITTEES 9 

DOING THE SAME WORK. IT'S GOING TO TAKE STAFF TIME AND ALL OF 10 

YOUR TIME TO PARTICIPATE, WHO ARE ON THAT COMMITTEE, AND SO I 11 

AM RECOMMENDING, TO THIS BODY, THAT WE DISBAND THE HOUSING 12 

SUBCOMMITTEE OF THE REGIONAL PLANNING COMMITTEE. IS THERE A 13 

SECOND?  14 

 15 

DIR. SCOTT HAGGERTY: SECOND.  16 

 17 

KAREN MITCHOFF, CHAIR: THANK YOU MR. HAGGERTY. IS THERE ANY 18 

DISCUSSION?  19 

 20 

CARLOS ROMERO: THIS IS CARLOS ROMERO, JESSE YOU GO FIRST. I 21 

SEE YOUR HAND.  22 

 23 

KAREN MITCHOFF, CHAIR: JESSE, GO AHEAD.  24 

 25 
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JESSE ARREGUIN: AS CHAIR MITCHOFF NOTED, THE HOUSING COMMITTEE 1 

WILL BE A STANDING COMMITTEE AND WE'RE WORKING WITH 2 

PARTNERSHIP WITH MTC ON ASSEMBLY BILL 1487 AND THE BAY AREA 3 

HOUSING FINANCE AUTHORITY AS WELL AS HOUSING POLICY ISSUES 4 

AND, AROUND HOMELESSNESS. AND I HAD A CONVERSATION WITH VICE 5 

MAYOR ROMERO PRIOR TO THIS MEETING WHICH HE MAY ALSO ADDRESS 6 

AROUND CONTINUING THE PRACTICE OF HAVING NON-ELECTED 7 

PARTICIPATION ON THE NEW HOUSING COMMITTEE. AND SO I'LL BE 8 

DISCUSSING WITH MS. MCMILLAN AND BRINGING FORWARD A SUGGESTION 9 

THAT WE HAVE SOME EX-OFFICIO NEW MEMBERS ON THIS HOUSING 10 

COMMITTEE TO CONTINUE A STAKEHOLDER PARTICIPATION IN THIS 11 

PROCESS.  12 

 13 

KAREN MITCHOFF, CHAIR: THANK YOU. MR. ROMERO?  14 

 15 

CARLOS ROMERO: YES MAYOR ARREGUIN STOLE MY THUNDER. WE 16 

CERTAINLY DISCUSSED IT AND HAD A CONVERSATION WITH STAFF ABOUT 17 

EFFICIENCY AND CONVERSATIONS WITH THE CHAIR OF ABAG MAYOR 18 

ARREGUIN, AGAIN, I AM -- WE ARE IN CONCURRENCE TO THE EXTEND 19 

THAT WE CAN BROADEN EXESTENTIAL MEMBERS ON THE OTHER COMMITTEE 20 

THAT WOULD BE GREAT. I DID THINK IF POSSIBLE, OF THE NON-21 

ELECTED MEMBERS WHO ARE ON THAT COMMITTEE, IF I MAY, PAUL 22 

CAMPOS, PAUL P, MATT REGAN, RODNEY NICKENS AND MELISSA WHO'S 23 

LAST TIME IN I'M FORGETTING, I WANT TO THANK THEM FOR THEIR 24 
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ACTIVE PARTICIPATION AND I APPRECIATE THEIR INPUT IN THE 1 

HOUSING COMMISSION.  2 

 3 

KAREN MITCHOFF, CHAIR: MAYOR ASHCRAFT?  4 

 5 

MARILYN EZZY ASHCRAFT: I AM IN SUPPORT. SUGGESTIONS RAISED BY 6 

MAYOR ARREGUIN AND VICE MAYOR ROMERO, SO CAN THE MOTION BE 7 

MODIFIED IF THAT IS ACCEPTABLE.  8 

 9 

KAREN MITCHOFF, CHAIR: WHAT DID YOU WANT TO MODIFY IT TO?  10 

 11 

MARILYN EZZY ASHCRAFT: WITH THE DIRECTION THAT CONTINUE TO 12 

HAVE SOME NON-ELECTED EX-OFFICIO MEMBERS OF THE MEMBERS OF THE 13 

ABAG HOUSING COMMITTEE.  14 

 15 

KAREN MITCHOFF, CHAIR: I BELIEVE THAT'S ALREADY BEEN MADE FROM 16 

PRESIDENT ARREGUIN WHEN WE DID IT AT THE ABAG EXECUTIVE 17 

COMMITTEE IS THAT CORRECT JESSE?  18 

 19 

JESSE ARREGUIN: WE WILL BE DOING THAT. I APPRECIATE THE 20 

SUPPORT MAYOR ASHCRAFT AND THAT IS SOMETHING WE'LL SUBMIT FOR.  21 

 22 

MARILYN EZZY ASHCRAFT: PUTTING THE CART BEFORE THE HORSE HERE.  23 

 24 
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JESSE ARREGUIN: ABAG EXECUTIVE BOARD HAS TO ADD SEATS TO THE 1 

COMMITTEE SO YOU HAVE MY COMMITMENT THAT WE'LL DO THAT.  2 

 3 

MARILYN EZZY ASHCRAFT: THAT'S IT FOR ME.  4 

 5 

KAREN MITCHOFF, CHAIR: NO RAISED HANDS. ANY PUBLIC COMMENT?  6 

 7 

CLERK OF THE BOARD: NO HANDS FROM ATTENDEES AND NO WRITTEN 8 

COMMENTS RECEIVED.  9 

 10 

KAREN MITCHOFF, CHAIR: OKAY. WITH THAT MAY I HAVE A ROLL CALL 11 

VOTE ON THE ACTION, MR. CASTRO?  12 

 13 

CLERK OF THE BOARD: [ROLL CALL VOTE]. -- MARK L?  14 

 15 

KAREN MITCHOFF, CHAIR: IS HE ON THE CALL? HE'S MY STAFF MEMBER 16 

WITH COUNTY PUBLIC WORKS.  17 

 18 

CLERK OF THE BOARD: I THOUGHT I SAW HIM. MAYBE HE'LL COME UP. 19 

[ROLL CALL - CONTINUED]. MOTION PASSES.  20 

 21 

KAREN MITCHOFF, CHAIR: THANK YOU MR. CASTRO. MOVING TO ITEM 22 

FOUR. ONE ITEM ON OUR CONSENT CALENDAR MINUTES FROM MAY 6TH, 23 

2020 MEETING. ANY COMMENTS, QUESTIONS, EDITS ON THAT FROM ANY 24 

COMMITTEE MEMBERS?  25 
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 1 

JULIE PIERCE: PIERCE MOVES.  2 

 3 

DIR. SCOTT HAGGERTY: HAGGERTY SECONDS.  4 

 5 

KAREN MITCHOFF, CHAIR: PUBLIC COMMENT.  6 

 7 

CLERK OF THE BOARD: NO TEND ATTENDEES WITH THEIR HAND RAISED 8 

AND NO WRITTEN PUBLIC COMMENT RECEIVED ON THIS ITEM.  9 

 10 

KAREN MITCHOFF, CHAIR: CALL ROLL ON THE VOTE, PLEASE.  11 

 12 

CLERK OF THE BOARD: [ROLL CALL VOTE]. MOTION PASSES.  13 

 14 

KAREN MITCHOFF, CHAIR: NEXT ITEM IS THE INFORMATIONAL ITEM. BE 15 

PRESENTED BY DAVE VAUTIN. >DAVE VAUTIN: GOOD AFTERNOON DAVE 16 

VAUTIN WITH MTC ABAG PLANNING TEAM AND PROJECT MANAGER. HAPPY 17 

TO BE HERE TODAY TO SHARE THE PLANNED BAY AREA 2050 DRAFT 18 

BLUEPRINT FINDING. I WANT TO UNDERSCORE THE WORK WE'RE SHARING 19 

TODAY REFLECTS THE JOINT EFFORT ACROSS THE REGIONAL PLANNING 20 

TEAM MTC ABAG PLANNING TEAM TO DO A LOT OF REALLY CHALLENGING 21 

LONG RANGE PLANS WORK DURING THE DIFFICULT CIRCUMSTANCES OF 22 

COVID-19 SHELTER-IN-PLACE PERIOD. PRESENTATION TODAY 23 

REPRESENTS THE OUTCOME OF THE DRAFT BLUEPRINT. YOU WILL 24 

RELEVANCE IN FEBRUARY MTC BOARD DIRECTED STAFF TO STUDY 25 
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STRATEGIES FOR TRANSPORTATION, HOUSING, ECONOMY, AND 1 

ENVIRONMENT. ALONG WITH A SET OF GROWTH GEOGRAPHIES FOR 2 

HOUSING AND JOBS TO UNDERSTAND HOW THEY ADVANCE REGIONAL 3 

HOUSING GOALS AND THESE ARE THE REGIONAL FOUNDATION OF THE 4 

DRAFT BLUEPRINT. THE DRAFT IS THE FIRST DRAFT OF PLANNED BAY 5 

AREA 2050 AND AN OPPORTUNITY TO REFLECT ON STRATEGY REVISIONS 6 

AND MAKE IMPROVEMENTS PRIOR TO THE FINAL DRAFT BLUEPRINT THIS 7 

FALL. I'M GOING TO ASK STAFF TO PULL UP THE PRESENTATION. 8 

THANK YOU. IT'S IMPORTANT TO MENTION THERE HAS BEEN A LOT OF 9 

DISCUSSION OF MAJOR TRANSPORTATION INVESTMENTS AS PART OF THE 10 

PLANNED BAY AREA 2050 PROCESS WE KNOW THIS IS ONE PIECE OF THE 11 

PUZZLE WE COMPLAINT ACHIEVE REGIONAL GOALS FOR GHG, EQUITY AND 12 

THE LIKE WITHOUT A BROADER SET OF STRATEGIES THAT INTEGRATE 13 

TOGETHER HOUSING TRANSPORTATION ECONOMIC AND ENVIRONMENTAL 14 

ACTION. THESE ARE GOING TO BE ESSENTIAL IN THE MONTHS AHEAD AS 15 

WE LOOK TOWARDS THE FINAL BLUEPRINT AND WORK TOWARDS ACHIEVING 16 

SB 375 GREENHOUSE GAS REDUCTION EFFORTS. WITH ALL OF THAT IN 17 

MIND LET'S JUMP INTO THE PRESENTATION. NEXT SLIDE PLEASE. 18 

SPEAKING OF THE TIMELINE FOR PLANNED BAY AREA 2050 THIS GRAPH 19 

HIGHLIGHTS A HIGHLIGHT OF JUNCTURE EFFORT REGIONAL HOUSING 20 

DRAFT BLUEPRINT. AFTER TWO YEARS OF HORIZON INITIATIVE 21 

FOLLOWED BY ROBUST STAKEHOLDER ENGAGEMENT IN THE FALL AND 22 

WINTER WE HAVE COMPLETED UNNECESSARY FOR THE DRAFT BLUEPRINT. 23 

SINCE THIS IS A MAJOR MILESTONE TODAY'S PRESENTATION IS A BIT 24 

LONGER THAN USUAL AND I ASK FOR YOUR INDULGENCE. PRESENTATION 25 
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IS IN FOUR CHUNKS. FIRST I'LL TALK ABOUT THE PROCESS TO DATE 1 

AND THE STRATEGIES ANALYZED. SECOND I'LL HIGHLIGHT THE 2 

FORECASTED OUTCOMES FROM THE DRAFT BLUEPRINT. THIRD WE'LL 3 

EXPLORE HOW WELL THE DRAFT BLUEPRINT MEETS THE GUIDING 4 

PRINCIPLES AND THE DRAFT AND FINALLY WE'LL TURN TO NEXT STEPS. 5 

NEXT SLIDE. NEXT SLIDE. THE WORK OF THE HORIZON INITIATIVE IS 6 

MORE TIMELY THAN EVER WE STRESS TESTED STRATEGIES THAT HAVE 7 

BEEN INTEGRATED INTO THE DRAFT BLUEPRINT AGAINST THREE VERY 8 

DIFFERENT FUTURES THESE FUTURES WERE DEFINED LIKE FORCES LIKE 9 

RISING TELECOMMUTING AND E-COMMERCE AND THE STRATEGIES THAT 10 

MADE THE CUT FOR THE DRAFT BLUEPRINT DECISIONIS WERE MADE 11 

BASED UPON RESILIENCY AND EQUITY BENEFITS. THIS WAS REALLY A 12 

GREAT OPPORTUNITY TO EXPLORE HOW DIFFERENT FORCES DIFFERENT 13 

REGIONAL TRAJECTORIES COULD AFFECT THE REGION'S FUTURE AND HOW 14 

WE COULD RESPOND AND MORE IMPORTANTLY ESPECIALLY IN THE COVID-15 

19 ENVIRONMENT HOW TO PIVOT WHEN THE SITUATION CHANGES. NEXT 16 

SLIDE. OF COURSE WHEN CREATING PLANNED BAY AREA 2050 WE MUST 17 

ADHERE TO STATE AND FEDERAL REGULATIONS. STATE AND FEDERAL 18 

AGENCIES APPROVE THE FINAL PLAN THIS INCLUDES TAKING A BEST 19 

GUESS AT EXTERNAL FORCES RECOGNITION THE FUTURE IS HIGHLY 20 

UNCERTAIN. WE DON'T DO THIS ALONE. WE DO IT IN CONCERT WITH 21 

THE CALIFORNIA AIR RESOURCES BOARD AS KEY REGULATOR OF THE 22 

LONG RANGE PLAN. THIS FOLLOWS MANY ASSUMPTIONS BUT THE BOTTOM 23 

LINE I WANT TO UNDERSCORE IT OFTEN MAKES IT HARDER TO ACHIEVE 24 

THE REGIONAL VISION FROM GAS PRICES TO GROWS INCOME AND 25 
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EQUALITY AND GREATER SHARE OF THE WEALTHY THOSE TRENDS NEED 1 

MORE DRIVING AND MORE GREENHOUSE GAS REDUCTION. TELECOMMUTING 2 

TO WORK WITH CARB TO INCREASE THE SHARE OF OFFICE WORKERS 3 

WORKING FROM HOME IN THE FUTURE. NEXT SLIDE. FOLLOWING ON THE 4 

EXTERNAL FORCES, THE DRAFT BLUEPRINT INCORPORATES THESE 25 5 

STRATEGIES ACROSS ALL FOUR ELEMENTS OF THE PLAN, 6 

TRANSPORTATION, HOUSING, THE ECONOMY, AND THE ENVIRONMENT. 7 

ULTIMATELY THIS IS AN INTEGRATED PROPOSAL RECOGNIZING THAT THE 8 

PAST PLANS FOCUS ON TRANSPORTATION ISN'T ENOUGH TO GET US 9 

TOWARD THE BRIGHTER FUTURE. THOSE TRANSPORTATION PROJECTS I 10 

MENTIONED ARE A SMALL BUT IMPORTANT PIECE OF THE PUZZLE 11 

BUNDLED TOGETHER WITH OTHER TRANSPORTATION STRATEGIES, HOUSING 12 

STRATEGIES, ECONOMIC STRATEGIES, AND ENVIRONMENTAL STRATEGIES. 13 

THINGS LIKE ROADWAY PRICING, DENSIFYING AROUND TRANSIT HUBS 14 

AND HIGH RESOURCE COMMUNITIES AND PROTECTING CRITICAL SEGMENTS 15 

OF SHORE LINES FROM SEA LEVEL RISE PLAY A CRITICAL ROLE IN THE 16 

REGION'S FUTURE. NEXT SLIDE. YOU HAVE SEEN THIS MATERIAL 17 

BEFORE, BUT WE WANT TO REFRESH ON WHAT IS MEANS TO MEET A 18 

STRATEGY IN PLANNED BAY AREA 2050. A STRATEGY IS A PUBLIC 19 

POLICY OR SET OF INVESTMENTS THAT CAN BE IMPLEMENTED NOT OVER 20 

THE NEAR TERM BUT OVER THE NEXT 30 YEARS. THEY'RE NOT 21 

LEGISLATIVE PROPOSALS EITHER. THEY ARE CONCEPTS THAT CAN BE 22 

INCORPORATED AT DIFFERENT LEVELS OF GOVERNMENT TO BRING ABOUT 23 

A BRIGHTER FUTURE FOR THE BAY AREA. IMPORTANTLY THE PLAN MUST 24 

BE FISCALLY CONSTRAINED WHICH MEANS WE CAN'T INCLUDE EVERY 25 
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STRATEGY OR GET TO ALL OF OUR GOALS. WE DO NEED TO IDENTIFY 1 

THE POTENTIAL FUTURE REVENUE SOURCES TO PAY FOR SOME OF THESE 2 

BOLD IDEAS. NEXT SLIDE. EVEN BEFORE THIS POINT IN THE PROCESS 3 

WE HAVE ENGAGED WITH THOUSANDS OF BAY AREA RESIDENTS IN FALL 4 

2019 WE GOT 13,000 COMMENTS THAT HELPED INFORM OUR VISION 5 

FORWARD STRATEGIES TO THE DRAFT BLUEPRINT. REMARKABLY 90 6 

PERCENT OF THE COMMENTS SUPPORTED STRATEGIES THAT WE WILL BE 7 

SHOWING TODAY. IN THE HORIZON INITIATIVE WE INTERACTED WITH 8 

TENS OF THOUSANDS MORE PEOPLE ON STRATEGIES THAT HAVE GONE 9 

INTO THREE YEARS OF HONING TO GET TO THIS POINT. NEXT SLIDE. 10 

YOU MAY RECALL THE 25 STRATEGIES FROM FOLLOW, WHEN WE 11 

PRESENTED THIS MATERIAL PREVIOUSLY. THERE IS AN ATTACHMENT IN 12 

YOUR PACKET THAT WALKS THROUGH ALL 25 OF THE STRATEGIES BUT I 13 

WANT TO QUICKLY RUN THROUGH THEM HERE CLUSTERED UNDER NINE 14 

CATEGORIES. THE DRAFT BLUEPRINT INCLUDES STRATEGIES TO 15 

MAINTAIN AND OPTIMIZE EXISTS INFRASTRUCTURE INCLUDING 16 

STRATEGIES RELATED TO PRICING OUR REGION'S HIGHWAYS. IT 17 

INCLUDES STRATEGIES TO CREATE HEALTHY AND SAFE STREETS BY 18 

REBUILDING LOCAL ARTERIALS MAKING THEM SAFER, CHANGING SPEED 19 

LIMITS AND ALSO BUILDING PROTECTED CYCLE AND PEDESTRIAN 20 

INFRASTRUCTURE. LASTLY IN TRANSPORTATION THE DRAFT BLUEPRINT 21 

CREATES A SHORT LIST OF TRANSPORTATION PROJECTS TO DESIGN OUR 22 

LOCAL AND REGIONAL TRANSIT SYSTEM AND THIS STRATEGY WILL BE 23 

EXPANDED IN THE FINAL BLUEPRINT. WHEN IT COMES TO HOUSING THE 24 

DRAFT BLUEPRINT INCLUDES A SUITE OF STRATEGIES THAT TOUCH ON 25 
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ALL THREE PS. PRODUCTION, PRESERVATION, AND PROTECTION. AND IT 1 

WORKS TO SPUR HOUSING PRODUCTION INCLUDES COMMUNITIES ACROSS 2 

THE BAY AREA AND PROTECT PRESERVE AND PRODUCE MORE DEED 3 

RESTRICTED AFFORDABLE HOUSING. WHEN IT COMES TO THE ECONOMY, 4 

THE DRAFT BLUEPRINT ATTEMPTED TO IMPROVE ECONOMIC MOBILITY 5 

THROUGH STRATEGIES LIKE CHILD CARE SUBSIDIES AND INCUBATOR 6 

PROGRAMS FOR NEW BUSINESSES AS WELL AS STRATEGIES TO ENCOURAGE 7 

JOBS TO RELOCATE TO HOUSING RICH AREAS IN THE REGION -- OFFICE 8 

DEVELOPMENT. YOU WILL SEE IN A MINUTE THESE STRATEGIES PROVE 9 

UNSUCCESSFUL IN SHIFTING JOBS FROM THE MAJOR CLUSTER IN SOUTH 10 

BAY AND SILICON VALLEY. LASTLY, THE BLUEPRINT INCLUDES 11 

STRATEGIES ON THE ENVIRONMENT. THE FIRST REGIONAL PLANNED BAY 12 

AREA JUST UNDER $20 BILLION PACKAGE OF SEA LEVEL RISE 13 

INFRASTRUCTURE IMPROVES FROM LEVIES AND RESTORATION TO PROTECT 14 

ALL OF OUR VULNERABLE COMMUNITIES FROM SEA LEVEL RISE TO 15 

RETROFIT AGAINST EARTHQUAKES AND INVESTING IN PARKS AND OPEN 16 

SPACE AND LAST BUT NOT LEAST ELECTRIFYING OUR TRANSPORTATION 17 

SYSTEM. NEXT SLIDE. OF COURSE THE STRATEGIES WERE APPROVED IN 18 

FEBRUARY AND YOU MAY ASK HOW OUR CURRENT REGIONAL NATIONAL AND 19 

GLOBAL CHALLENGES WITH COVID-19 AFFECT THEM. PLANNED BAY AREA 20 

2050 IS A 30 YEAR PLAN AND THE IMPACT FROM COVID-19 AND 21 

RECESSION WILL BE MOST SIGNIFICANT IN NEXT 5 TO 10 YEARS. 22 

SECOND WHILE WE DIDN'T STUDY A PANDEMIC IN HORIZON WE STUDIED 23 

MANY FORCES ARE COMING ALONG WITH IT, HIGH LEVELS OF 24 

TELECOMMUTING WITH TRANSIT PROJECTS TO MAKE SURE THEY MADE 25 
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SENSE IN A WORLD WITH HIGH TELECOMMUTES AND A BOOMING GROWTH 1 

CYCLE WITH THE RISING TIDES FALLING FINANCES FUTURE WHICH 2 

SHOWED HOUSING STRATEGIES ARE ESSENTIAL REGARDLESS OF OUR 3 

REGION'S ECONOMIC BOOM AND BUST CONDITIONS. SOME OF THE 4 

STRATEGIES SEEM MORE TIMELY NOW IN THE PANDEMIC ERA THINGS 5 

LIKE BICYCLE IMPROVEMENTS THAT MAY BE NECESSARY IN A WORLD 6 

WHERE TRANSIT HAS REQUIREMENTS, AND PROTECTIONS FOR RENTERS 7 

WHO ARE WORRIED ABOUT BEING DISPLACED DURING THE CRISIS 8 

FUNDING FOR ESSENTIAL WORKERS CHILD CARE SUBSIDIES AND 9 

PROTECTIONS OF MUCH NEEDED OPEN SPACE WHICH I THINK WE ALL 10 

VALUE AS WE'RE SPENDING SO MUCH MORE TIME COOPED UP AT HOME. 11 

NEXT SLIDE. ANOTHER KEY ASPECT OF THE DRAFT BLUEPRINT WERE THE 12 

GROWTH GEOGRAPHIES EXPANDED TO ENCOURAGE MORE GROWTH IN HIGH 13 

RESOURCE AREAS. YOU WILL SEE THE MAP ON THE RIGHT SHOWS 14 

PRIORITY DEVELOPMENT AREAS KEY BUILDING BLOCKS OF PRIOR 15 

PLANNED BAY AREAS AND EXPANDED GROWTH AREAS HIGHLIGHTED IN 16 

ORANGE AND BLUE THAT HELPS TO FURTHER MOVE US TOWARDS CLIMATE 17 

AND EQUITY GOALS COMPARED TO THE PRIOR PLAN. AGAIN, WE'RE 18 

CONTINUING TO PROTECT AREAS OUTSIDE URBAN GROWTH BOUNDARIES AS 19 

WELL AS UNMITIGATED HIGH HAZARD AREAS IN ALL OF THIS LAND USE 20 

MODELING. NEXT SLIDE. WHILE PLANNED BAY AREA 2050 IS LESS 21 

ORIENTED TOWARDS THE FINANCIAL AND INVESTMENT ASPECT OF PRIOR 22 

PLANS, AS IT IS MORE OF A STRATEGY ORIENTED PLAN TO ADVANCE 23 

THE REGION IT STILL MUST BE FISCALLY CONSTRAINED AND THIS SEW 24 

PARTICULARLY ESSENTIAL IN THE WORLD OF TRANSPORTATION WHERE 25 
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THERE ARE STATUTORY REQUIREMENTS. YOU WILL SEE A BREAK DOWN 1 

FOR EACH ELEMENT OF THE PLAN INCLUDING ASSUMPTIONS ABOUT NEW 2 

REGIONAL REVENUES THAT ARE ESSENTIAL TO MAKE PROGRESS 3 

IDENTIFIED IN THE PRESENTATION. AND IN TOTAL IT'S IMPORTANT TO 4 

NOTE MORE THAN $200 BILLION IN REVENUES FOR ALL AREAS WOULD BE 5 

NEEDED TO MAKE KEY HEADWAY HERE. THERE IS A FEW CAVEATS HERE 6 

BUT MOST IMPORTANT FOR THIS COMMITTEE IS TO HIGHLIGHT 7 

HIGHLIGHT THE CAVEAT TO AFFORDABLE HOUSING. WHILE THERE IS 8 

ROBUST MONEY IN THE DRAFT BLUEPRINT THERE IS STILL ENORMOUS 9 

GAP IN NEEDS AND ASSESSMENT OF 3 TO $400 BILLION. WE'RE 10 

OCCURRING HOW TO ADDRESS THIS IN THE FINAL BLUEPRINT, THAT 11 

WILL BE KEY DISCUSSION. THERE WILL BE OPPORTUNITY ON HOW WE 12 

SLICE THE PIE FOR EACH OF THE AREAS BUT IT'S ESSENTIAL TO 13 

REMEMBER THAT IT'S NOT ENOUGH TO SLICE THE PIE DIFFERENTLY LOW 14 

COST AND NO COST STRATEGIES ESPECIALLY IN PLACES LIKE HOUSING 15 

CAN AUGMENT OUR FINANCIAL INVESTMENT SUPERVISOR OFTEN MAKE 16 

MUCH MORE HEADWAY. NEXT SLIDE. YOU MAY BE WONDERING HOW WE 17 

FORECAST THE OUTCOMES FOR THESE STRATEGIES. THAT'S NEVER BEEN 18 

MORE DIFFICULT THAN IN THE UNCERTAIN WORLD WE LIVE IN TODAY. 19 

WE HAVE DONE OUR BEST TO TRY TO UNDERSTAND HOW WE CAN FURTHER 20 

REFINE STRATEGIES GOING FORWARD. WE DO IT BY TAKING BASELINE 21 

DATA AND INCORPORATE BEING THE STRATEGIES OF THE GROWTH 22 

GEOGRAPHIES APPROVED FOR ANALYSIS BY THE BOARD IN FEBRUARY. WE 23 

THEN RUN THIS THROUGH A SERIES OF ECONOMIC AND LAND USE MODELS 24 

FOR OUTCOMES AND POTENTIAL REGIONAL GROWTH PATTERNS AND THAT'S 25 
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WHAT WE HAVE RELEASED HERE IN JULY. NEXT SLIDE. SO WHAT ARE 1 

THE POTENTIAL OUTCOMES OF THE DRAFT BLUEPRINT? OF COURSE I 2 

WANT TO UNDERSCORE HERE THE FACT THAT WE LIVE IN SUCH 3 

UNCERTAIN TIMES. WE HAVE DONE OUR BEST TO TRY TO UNDERSTAND 4 

THE POTENTIAL OUTCOMES. NEXT SLIDE. WE'LL START WITH THE GOOD 5 

NEWS. DRAFT BLUEPRINT IS THE FIRST PLANNED BAY AREA THAT MAKES 6 

HEADWAY ON OUR REGION'S UNAFFORDABILITY CRISIS. IN 2015 THE 7 

AVERAGE HOUSEHOLD SPENT 57 PERCENT OF THEIR TAKE HOME PAY ON 8 

HOUSING AND TRANSPORTATION, MUCH HIGHER THAN SOME OTHER 9 

PLAYERS IN THE UNITED STATES. WITH THE HOUSING STRATEGIES, AND 10 

THE 1.5 MILLION NEW HOMES, MANY OF THEM AFFORDABLE, IN THE 11 

DRAFT BLUEPRINT WE'RE ABLE TO DRIVE THAT DOWN TO 48 PERCENT OF 12 

HOUSEHOLD INCOME BY 2050 AND WHILE STILL HIGH IT'S A 13 

MEANINGFUL IMPROVEMENT COMPARED TO PAST PLANS AND CURRENT 14 

CONDITIONS. IN FACT THOSE GAINS ARE GREATER FOR LOW INCOME 15 

HOUSEHOLDS THANKS TO DIRECT INVESTMENT IN AFFORDABLE HOMES 16 

OVER 20,000 THROUGH 2050 AND HOMES LOCATED WITHIN WALKING 17 

DISTANCE OF TRANSIT WE'RE ABLE TO BRING A SHARE OF BAY AREA 18 

HOMES WITHIN A QUICK WALK OF PUBLIC TRANSPORTATION FROM 30 19 

PERCENT IN 2015 TO 43 PERCENT IN 2050. NEXT SLIDE. LET'S TURN 20 

TO THE ENVIRONMENT NOW. WHAT DOES THE DRAFT BLUEPRINT DO ON 21 

THAT FRONT? OUR ACTIONS TO MAKE OUR LOCAL STREETS ARTERIALS 22 

AND HIGHWAYS SAFER WOULD ENABLE US TO SAVE 1500 LIVES THROUGH 23 

2050. WHILE NOT ENOUGH TO GET US TO ZERO FATALITIES A 24 

MEANINGFUL STEP IN THE RIGHT DIRECTION AND MORE EFFORT COULD 25 
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BE CONSIDERED THROUGH BOLDER ACTION IN THE FINAL BLUEPRINT. 1 

WHEN IT COMES TO THE RESILIENCE TO HAZARDS INCORPORATION OF 2 

SEA LEVEL RISE AND EARTHQUAKE PROTECTION FOR THE FIRST TIME IN 3 

PLANNED BAY AREA ENSURES THAT 98 PERCENT OF HOMES AT RISK OF 4 

SEA LEVEL RISE WOULD BE PROTECTED BY THE SYSTEM OF LEVIES AND 5 

OTHER SORTS OF INFRASTRUCTURE THAT WE DISCUSSED EARLIER AND 6 

THAT 100 PERCENT OF HOMES AT HIGH RISK OF DESTRUCTION AND 7 

EARTHQUAKE WOULD BE RETROFITTED. AND LASTLY SIGNIFICANT 8 

REVENUES NEEDED TO FUND THESE STRATEGIES, THE REVENUES 9 

GENERATED ENABLE US TO HELP LOW INCOME RESIDENTS INCLUDING 10 

WITH THE CHILD CARE SUBSIDIES AND OTHER PROGRAMS TO ADVANCE 11 

EQUITY GOALS AND ALLOW US TO REINVEST IN HOUSING 12 

INFRASTRUCTURE ALL CONTRIBUTING TO ECONOMIC GROWTH IN THE BAY 13 

AREA. NEXT SLIDE. THIS SLIDE HERE SHOWS THE REGIONAL GROWTH 14 

FORECAST WHICH NOW INTEGRATES ALL OF THE COVID-19 AND 15 

RECESSION IMPACT OF THE 2019 PERIODS. YOU WILL NOTE THE DRAFT 16 

BLUEPRINT INCLUDES HOMES OVER THE LIFESPAN AND 40 MILLION JOBS 17 

IN BASELINE CONDITIONS. ONE NEW HOME FOR EVERY NEW JOB WHICH 18 

IS ESSENTIAL FOR US TO ADDRESS THE JOBS HOUSING IMBALANCE THAT 19 

HAS LONG EXISTED IN THE BAY AREA. NEXT SLIDE. WE'LL SHOW BREAK 20 

DOWNS ON THE COUNTY LEVEL. PLANNED BAY AREA 2040 SHOWN ON THE 21 

LEFT AND THE DRAFT BLUEPRINT FOR PLANNED BAY AREA 2050 ON THE 22 

RIGHT. NEW HOUSEHOLDS IN EACH COUNTY. A FEW OBSERVATIONS HERE. 23 

FIRST YOU WILL NOTICE THE BUBBLES ON THE RIGHT SIDE FOR 24 

PLANNED BAY AREA 2050 ARE GENERALLY LARGER THAN THOSE ON THE 25 
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LEFT SIDE, THAT'S A REFLECT OF THE GREATER AMOUNT OF TOTAL 1 

REGIONAL HOUSING GROWTH IN PLANNED BAY AREA 2050. ALSO NOTE 2 

THE SHARED GROWTH IN THE SOUTH BAY IS SIGNIFICANTLY LARGER 3 

THAN THE LAST PLAN. SOMEWHAT SMALLER GROWTH IN EACH BAY AND 4 

SAN FRANCISCO, SIMILAR LEVELS OF GROWTH IN MANY OF THE OTHER 5 

COUNTIES IN TERMS OF THE SHARE. IN MOST COUNTIES THE TOTAL 6 

NUMBER OF UNITS IS EITHER EQUIVALENT OR HIGHER THAN THE LAST 7 

PLAN. YOU WILL NOTE FROM KEY STATISTICS FROM THE LOWER LEFT OF 8 

EACH GRAPHIC IT SHOWS SLIGHTLY LESS GROWTH IN THE THREE CITIES 9 

SAN JOSE OAKLAND, AND BAYSIDE COMMUNITIES THAT TOUCH SAN 10 

FRANCISCO BAY, AND RELATIVELY COMPARABLE INLAND. SHARED GROWTH 11 

IN PRIORITY DEVELOPMENT AREAS IS ALSO REDUCED AS GROWTH IS 12 

MORE DISTRIBUTED TO OTHER TRANSIT-RICH AND HIGH RESOURCE AREAS 13 

WHICH HELP US GET TO THOSE CLIMATE AND EQUITY GOALS. NEXT 14 

SLIDE.  15 

 16 

DIR. SCOTT HAGGERTY: I CAN ASK A QUESTION ON THIS SLIDE? >DAVE 17 

VAUTIN: SURE.  18 

 19 

DIR. SCOTT HAGGERTY: DAVE, I HAVE NEVER NOTICED THIS BEFORE. 20 

[LAUGHTER] -- I MEAN, I HATE TO SAY THIS, I ALWAYS LOOKED AT 21 

THIS AND I THOUGHT IT WAS LIKE SANTA CLARA COUNTY. BUT THAT 44 22 

PERCENT, 2015 DRAFT BLUEPRINT, THAT'S SAN JOAQUIN COUNTY. 23 

>DAVE VAUTIN: IN TERMS OF THE TOTAL NUMBER OF JOBS COMPARABLE 24 

TO THE TOTAL OF SAN JOAQUIN?  25 
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 1 

DIR. SCOTT HAGGERTY: NOPE I'M JUST TRYING TO ASK YOU. I'M 2 

FEELING A LITTLE BIT CHALLENGED RIGHT NOW MAYBE BECAUSE I HAVE 3 

HO ENDLESS DISCUSSIONS OF COVID TODAY. 44 FOR, WHAT IS THAT? 4 

WHAT COUNTY IS THAT?  5 

 6 

CINDY CHAVEZ: SANTA CLAIR. >DAVE VAUTIN: YES. THAT'S SANTA 7 

CLARA.  8 

 9 

DIR. SCOTT HAGGERTY: THANK YOU. I APPRECIATE THAT. WHEN I 10 

ASKED THE QUESTION I THOUGHT MAN, MAYBE I AM WRONG. GOOD TO 11 

KNOW. THANK YOU. >DAVE VAUTIN: NO PROBLEM. SO JUST TO SET THE 12 

STAGE FOR THIS SLIDE, THIS IS A SIMILAR BREAK DOWN FOR JOBS 13 

BASED ON PLANNED BAY AREA 2040 VERSUS THE DRAFT BLUEPRINT. YOU 14 

WILL SEE A TREND WITH GREATER SHARE OF GROWTH AGAIN IN THE 15 

SOUTH BAY AREA COMPARED TO PLANNED BAY AREA 2040. WHILE THERE 16 

WERE SOME BENEFITS OF OUR JOBS HOUSING IMBALANCE STRATEGY THAT 17 

TRIED TO SHIFT JOBS TO MORE HOUSING RICH COMMUNITIES NOTABLY 18 

ADDING GROWTH IN CENTRAL AND SOUTHERN COUNTIES AS THEY APPLIED 19 

TO JOB RICH COMMUNITIES ULTIMATELY THIS DOES NOT LEAD TO A 20 

SIGNIFICANT SHIFT OF JOBS OUT OF THE JOB RICH SANTA CLARA 21 

AREA. WE WERE MUCH MORE SUCCESSFUL IN OUR HOUSING STRATEGY OF 22 

BRINGING HOUSING CLOSER TO JOB CENTERS THAN WE WERE 23 

ENCOURAGING EMPLOYERS TO LOCATE JOBS ELSEWHERE. IN A WORLD OF 24 

GREATER TELECOMMUTING THIS REFLECTS WHERE THE CUBICLE OR 25 
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OFFICE IS FOR TYPICAL OFFICE WORKERS. MANY WORKERS DON'T HAVE 1 

TO GO TO THE OFFICE EVERY DAY OF THE WEEK BUT THE JOB SITES 2 

CONTINUE TO CLUSTER IN THE SOUTH BAY IN PARTICULAR. WHEN WE 3 

THINK ABOUT THE FINAL BLUEPRINT WE THINK ABOUT FURTHER 4 

STRATEGIES ADVANCING IN ORDER TO SHIFT THE LOCATION OF JOBS. 5 

NEXT SLIDE. LET'S LOOK AT TRANSPORTATION FOR A MOMENT. ON THE 6 

LEFT YOU WILL SEE A BREAK DOWN OF MODAL CHOICES FOR COMMUTING 7 

IN 2015. ON THE RIGHT YOU WILL SEE THE 2050 BLUEPRINT 8 

CONDITIONS. WE'RE FORECASTING ROUGHLY A 17 PERCENT REDUCTION 9 

IN AUTO MODE SHARE THANKS TO GROWING USE OF TELECOMMUTING 10 

INCREASED BICYCLING AND INCREASED USE OF PUBLIC TRANSPORTATION 11 

THANKS TO LAND USE AND TRANSPORTATION STRATEGIES. THIS IS A 12 

MEANINGFUL SHIFT IN BOTH COMMUTER MODE CHOICES. NEXT SLIDE. 13 

WHEN IT COMES TO SEA LEVEL RISE, YOU SEE A BREAK DOWN HEREOF 14 

WHERE THE BENEFITS ARE ACCRUING FROM THE SEA LEVEL RISE 15 

PROTECTIONS INCLUDED IN THE PLAN THE NETWORK OF LEVIES AND 16 

OTHER INFRASTRUCTURE I TALKED ABOUT, THE 90 PERCENT, YOU CAN 17 

SEE WITH THE BUBBLE SIZE THERE WHERE THE NUMBER OF HOMES THAT 18 

ARE AT RISK FROM FLOODING. THESE ACTIONS, IN TOTAL, TOTAL 19 

ABOUT $18 MILLION OF INVESTMENTS I WANT TO MAKE SURE 20 

COMMUNITIES WHICH ARE OFTENTIMES COMMUNITIES OF CONCERN OR KEY 21 

GROWTH AREAS ARE PROTECTED. 2,000 HOUSING UNITS WOULD REMAIN 22 

AT RISK AND THOSE ARE AREAS WHERE IT MAY BE APPROPRIATE TO 23 

CONSIDER STRATEGIC RETREAT. ON OTHER FRONTS THE SET OF 24 

IMPROVEMENTS IN TERMS OF SEA LEVEL RISE PROTECT 100,000 ACRES 25 



July 16, 2020 

 25 

OF MARSH LAND TO EXPAND MARSHES IN SAN FRANCISCO BAY AND 1 

PROTECT FROM FLOODING OR ACTIONS TO MITIGATE OR ELEVATE 2 

TRANSPORTATION NETWORKS TO ENSURE ALL MAJOR HIGHWAY AND RAIL 3 

CORRIDORS ARE PROTECTED AT TWO FEET OF SEE LEVEL RISE IN 2050. 4 

BEYOND 2050 IS TACKLING INCREASING SEA LEVEL RISE AFTER 2050. 5 

NEXT SLIDE. ONE KEY AREA FOR THE PLAN IS TO ADVANCE TOWARDS 6 

FEES FOR GREENHOUSE GAS EMISSIONS TARGETS FOR CARS AND LIGHT 7 

DUTY TRUCKS FOR STANDARDS ESTABLISHED BY THE STATE OF 8 

CALIFORNIA THIS TARGET HAS BEEN 15 PERCENT PER PERSON BY THE 9 

YEAR 2035 BUT IN 2019 THE STATE INCREASED THE TARGET TO 19 10 

PERCENT PER PERSON. LAST ITERATION OF PLANNED BAY AREA BARELY 11 

HIT THE 15 PERCENT TARGET BUT CONDITIONS OUTSIDE OF THE 12 

PLANNING ENVIRONMENT THINGS LIKE DEMOGRAPHICS OR THE COST OF 13 

GASOLINE HAVE CONTINUED TO EVOLVE. SO IF WE SIMPLY READOPTED 14 

PLANNED BAY AREA 2040 TODAY WE ANTICIPATED ITS BENEFITS WOULD 15 

DWINDLE TO A MERE ONE TO FOUR POINTS OF GHG REDUCTION, LEAVING 16 

A SIGNIFICANT A GAP. SEVEN POINTS WOULD BE REMAINING TO MEET 17 

THE NEW TARGET. THIS WILL BE A KEY DISCUSSION AREA AS WE MOVE 18 

INTO THE FINAL BLUEPRINT GIVEN THE DRAFT BLUEPRINT INCLUDED NO 19 

MAJOR HIGHWAY INVESTMENTS THOSE STRATEGIES WHICH ARE UNDER 20 

CONSIDERATION FOR INTEGRATION WITH THE FINAL BLUEPRINT IT MAKE 21 

THIS GAP BIGGER. WHAT STRATEGIES CAN WE BRING TO BEAR TO CLOSE 22 

THE GAP. TRANSPORTATION MONEYS WOULD FLOW TO OTHER REGIONS OF 23 

CALIFORNIA LIKE LOS ANGELES IF THE BAY AREA FAILS TO SOLVE 24 

THIS PROBLEM THROUGH PLANNED BAY AREA 2050. NEXT SLIDE. THIS 25 
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BRINGS ME TO THE THIRD PART OF THE PRESENTATION. HOW DOES THE 1 

DRAFT BLUEPRINT ALIGN WITH THE GUIDING PRINCIPLES ADOPTED BY 2 

ABAG AND MTC BOARD? NEXT SLIDE. FIRST OF ALL I SHOULD NOTE THE 3 

DRAFT BLUEPRINT STRATEGIES EXCEL OUR ACTIONS IN THE FUTURE, 4 

FUTURE GROWTH, FUTURE TRANSPORTATION INVESTMENTS, FUTURE 5 

CLIMATE PROTECTIONS, ARE MORE EQUITABLE AND MORE RESILIENT 6 

THAN PAST GENERATIONS HOWEVER MANY WRONGS OCCURRED IN THE 20th 7 

INDUSTRY AND RIGHTING THOSE WRONGS REQUIRES BOLD ACTION ON ALL 8 

FRONTS. NEXT SLIDE. YOU WILL FIND MANY MORE DATA POINTS THAN 9 

WE HAVE TIME TO COVER TODAY IN ATTACHMENT C, ALSO POSTED ON 10 

PLANNEDBAYAREA.ORG/BLUEPRINT. I'LL HIGHLIGHT TEN EVALUATION 11 

QUESTIONS, TWO FOR EACH OF THE GUIDING PRINCIPLES TO GIVE YOU 12 

A FLAVOR OF WHERE THE BLUEPRINT IS ACHIEVING THE GOALS LAID 13 

OUT BY THE BOARD. NEXT SLIDE. THE DRAFT BLUEPRINT MAKES THE 14 

BAY AREA MORE AFFORDABLE. FIRST DO RESIDENTS SPEND LESS ON 15 

HOUSING AND TRANSPORTATION. WE COVERED THIS PREVIOUSLY THE 16 

ANSWER IS YES AND THE REDUCTION IS GREATER FOR LOWER INCOME 17 

HOUSE HOLDS WHICH ARE DISPROPORTIONATELY HURTING. IT'S A 18 

MEANINGFUL STEP IN THE RIGHT DIRECTION. MEANS-BASED TOLLS 19 

INCLUDED INTO THE DRAFT BLUEPRINT ARE MITIGATED IN EQUITY 20 

IMPACTS ASSOCIATED WITH TOLLING. AND MEANS-BASED FARES CREATE 21 

REDUCTION OF COST BURDENS. SECOND WILL THE DRAFT BLUEPRINT 22 

SERVE MORE AFFORDABLE HOUSING? THE ANSWERS IS YES IT PRODUCES 23 

400,000 MORE UNITS SHORT OF THE REGIONAL NEED. WHILE 24 

PROTECTING DEED RESTRICTED UNITS AND PRODUCING UNITS TO 25 
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ACCOMMODATE FUTURE LOW INCOME HOUSING GROWTH WHICH WILL OCCUR 1 

IN THE WORLD OF CONTINUED INCOME EQUALITY THERE IS STILL 2 

THOUSANDS OF BAY AREA HOUSEHOLDS THAT WOULD NEED LOW INCOME 3 

DEED RESTRICTED UNITS KEY CHALLENGE NUMBER ONE FOR THE FINAL 4 

BLUEPRINT WILL BE HOW DO WE PRODUCE MORE AFFORDABLE HOMES IN 5 

THE REGION WITH WELL RESOURCED SCHOOLS AND OTHER AMENITIES. 6 

NEXT SLIDE. SECOND, DOES THE DRAFT BLUEPRINT MAKE THE BAY AREA 7 

MORE CONNECTED? 96ED BAG HERE. ANSWER IS YES FOR TRANSIT, 8 

BETTER ACCESS TO JOBS, PARTICULARLY FOR COMMUNITIES OF CONCERN 9 

WHICH IS A KEY EQUITY AREA. THANKS TO THE BUS AND BART 10 

INVESTMENT IN THE DRAFT BLUEPRINT AND YET RISING TRAFFIC 11 

CONGESTION COMBINED TO A SECONDARY DEGREE WITH SPEED LIMIT 12 

POLICIES PLAY A ROLE IN AUTO REDUCTION. THERE'S A TRADEOFF 13 

THERE THAT WILL BE CONSIDERED IN THE FINAL DRAFT BLUEPRINT. 14 

RELIABILITY FOR TRANSIT OPERATORS IN THE MATERIALS I WOULD 15 

NOTE THE MEANS-BASED TOLL, SOMETIMES NOT ENOUGH TO MITIGATE 16 

IMPACTS OF ALL POPULATIONS. WITH MUNI, AC TRANSIT, AND BART, 17 

AND OTHER SYSTEMS SUCH AS CALTRAIN, ARE FORECASTED TO HAVE 18 

TRANSIT CROWDING CHALLENGES BY THE TIME WE GET TO 2050. KEY 19 

QUESTIONS HERE IS WHAT ADDITIONAL STRATEGIES INCLUDING 20 

STRATEGIES THAT ARE GOING TO BE CONSIDERED BY THE COMMISSION 21 

NEXT WEEK CAN HELP US BETTER ADDRESS TRAFFIC CONGESTION AND 22 

TRANSIT OVERCROWDING. NEXT SLIDE. DOES THE DRAFT BLUEPRINT 23 

PROTECT OUR REGION'S DIVERSITY AND MAKE IT MORE DIVERSE IN THE 24 

FUTURE? WHAT WE'RE SEEING HERE ARE SOME CHALLENGE AREAS FOR 25 
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EQUITY T WHILE HIGH RESOURCE AREAS BECOME MORE INCLUSIVE THESE 1 

ARE PLACES THAT ARE OFTEN RACIALLY EXCLUSIVE IN PAST DECADES. 2 

IT WOULD REQUIRE ACTION TO ENSURE FOLKS CAN LIVE IN THOSE 3 

AREAS. TRANSIT-RICH AREAS ARE AT RISK OF GENTRIFICATION. 4 

THAT'S A KEY AREA TO EXPLORE GOING FORWARD IN TERMS OF 5 

STRATEGIES. AND BAY AREA RESIDENTS MAY NOT BE ABLE TO STAY IN 6 

PLACE OVER THE LONG-TERM EVEN WITH RENT PROTECTION POLICIES 7 

THINGS THAT EXIST TODAY IN SAN FRANCISCO BUT ARE NOW BEING 8 

STUDIED ACROSS THE REGION LOW INCOME RESIDENTS WOULD CONTINUE 9 

TO BE AT HIGH RISK OF DISPLACEMENT ESPECIALLY IN COMMUNITIES 10 

OF CONCERN.  11 

 12 

KAREN MITCHOFF, CHAIR: DID WE LOSE YOU DAVE? OR IS IT JUST ME?  13 

 14 

PAT ECKLUND: I THINK WE DID.  15 

 16 

KAREN MITCHOFF, CHAIR: DAVE, WE LOST YOU.  17 

 18 

PAT ECKLUND: YEAH.  19 

 20 

KAREN MITCHOFF, CHAIR: BUT I DON'T SEE THAT YOU'RE MUTED. SO. 21 

OKAY. HE'S CONNECTING TO AUDIO AGAIN. WE'LL GIVE HIM A MINUTE. 22 

NOW YOU NEED TO UNMUTE. THERE YOU GO. >DAVE VAUTIN: CAN YOU 23 

HEAR ME NOW?  24 

 25 
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KAREN MITCHOFF, CHAIR: YES. THANK YOU DAVE. >DAVE VAUTIN: 1 

SORRY ABOUT THAT. GO TO THE NEXT SLIDE PLEASE. NEXT WE'RE 2 

EXPLORING WHETHER THE DRAFT BLUEPRINT MAKES THE BAY AREA 3 

HEALTHIER WHEN IT COMES TO ROADWAY SAFETY I NOTED GAINS IN 4 

TERMS OF SAVING LIVES BUT EXPANDED STRATEGIES WOULD BE NEEDED 5 

TO MAKE THE BAY AREA SAFER AND HEALTHIER FOR ALL USERS OF OUR 6 

TRANSPORTATION SYSTEM. THE DRAFT BLUEPRINT PROTECTS HOMES AT 7 

RISK OF SEA LEVEL RISE THANKS TO INVESTMENTS IT HIGHLIGHTS 8 

IMPORTANCE OF SPENDING MONEY SO YOU DON'T HAVE TO REBUILD 9 

COMMUNITIES ELSEWHERE. DRAFT BLUEPRINT MAKES THE BAY AREA 10 

HEALTHIER AND SAFER IN TERMS OF GREENHOUSE GAS EMISSIONS BUT 11 

IT DOESN'T GO FAR ENOUGH AND A MORE CONCERTED EFFORT MAY BE 12 

NECESSARY TO CLOSE THE SIZABLE REMAINING GAP THAT DEFINES THE 13 

FOURTH CHALLENGING FOR THE FINAL BLUEPRINT. NEXT SLIDE. LASTLY 14 

WE'LL FOCUS ON THE REGION'S ECONOMY OF ECONOMIC VIBRANCY. ONE 15 

KEY CHALLENGE THAT WE'RE ASKED TO EXPLORE WAS BALANCE OF JOBS 16 

AND HOUSING. ANSWER HERE IS A BIT OF A MIX. WE'RE ABLE TO 17 

SHIFT MORE HOUSING CLOSER TO EXISTING JOB CENTERS BUT WEREN'T 18 

ABLE TO DO THE OPPOSITE IN THE DRAFT BLUEPRINT. SILICON VALLEY 19 

AND SAN FRANCISCO BECOME MORE BALANCE IN THE DRAFT BLUEPRINT 20 

BUT EAST BAY AND NORTH BAY SEE MORE LIMITED JOB GROWTH. LASTLY 21 

BAY AREA THE BAY AREA BUSINESSES WILL THRIVE WITH SELECT 22 

INDUSTRIES AND EXPECT TO SEE ROBUST GROWTH. WHILE EXPERIENCING 23 

A RECESSION TODAY WE BELIEVE THE REGION IS POISED FOR AN 24 

ECONOMIC REBOUND OVER THE NEXT DECADE AND TAX MEASURES COULD 25 
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ENABLE GAINS TO BE SHARED BY ALL BAY AREA RESIDENTS. KEY 1 

CHALLENGE IS THINKING ABOUT HOW AMBITIOUS STRATEGIES COULD BE 2 

EMPLOYED TO CREATE BETTER JOBS THROUGHOUT THE REGION. NEXT 3 

SLIDE. THIS IS THE TIP OF THE ICEBERG IN TERMS OF THE 4 

STAKEHOLDER ENGAGEMENT TO GET FEEDBACK ON THE FIVE CHALLENGES. 5 

THAT WILL BE THE FOCUS OF MANY PUBLIC AND STAKEHOLDER 6 

WORKSHOPS ARE IN THE COMING WEEKS. NEXT SLIDE. AS WE DEVELOP 7 

SOLUTIONS IT'S IMPORTANT FOR US TO REMAIN COMMITTED ESPECIALLY 8 

AT THIS POINT IN TIME WHERE EQUITY IS THE FOREFRONT OF ALL OUR 9 

MINDS TO 11 TO AFFECTED COMMUNITIES DIRECTLY. WE HAVE ALREADY 10 

CONDUCTED FOCUS GROUPS IN MANY DIFFERENT BAY AREA COMMUNITIES 11 

TO LISTEN TO LOW INCOME COMMUNITIES AND COMMUNITIES OF COLOR 12 

ABOUT THEIR NEEDS FOR HOUSING, TRANSPORTATION, AND THE LIKE. 13 

YOU CAN SEE SOME OF THEIR COMMENTS HERE ON THIS SLIDE. WE'LL 14 

BE BRINGING BACK A MORE COMPREHENSIVE REPORT ON THE ENGAGEMENT 15 

WE HAVE DONE THROUGH PLANNED BAY AREA 2050 IN SEPTEMBER. I 16 

THANK YOU FOR YOUR PATIENCE. THIS IS THE FINAL LAST FEW SLIDES 17 

ON THE BLUEPRINT. THIS WAS A MAJOR MILESTONE FOR OUR LONG-18 

RANGE PLANNING WORK AND WE'RE BEGIN BEING THE TRANSITION TO 19 

THE FINAL BLUEPRINT PHASE LAST STEP BEFORE WE GO INTO EIR THIS 20 

FALL. WE'RE SEEKING INPUT. WE'RE INCLUDING INPUT FROM AS MANY 21 

BAY AREA COMMUNITIES AS POSSIBLE. WE'RE HOLDING NINE COUNTY 22 

SPECIFIC VIRTUAL WORKSHOPS FIVE TELEPHONE TOWN HALLS IN FOUR 23 

LANGUAGES THREE VIRTUAL STAKEHOLDER WORKSHOPS ON DIFFERENT 24 

AREAS OF TOPICS OF THE PLAN AND FOCUSED COMMUNITY-BASED 25 
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ORGANIZATIONS. WE'RE ALSO HOLDING OFFICE HOUR OPPORTUNITIES 1 

FOR LOCAL JURISDICTION. WE SENT OUT FLYERS AND HAVE AN ONLINE 2 

SURVEY. WE HAVE DEVELOPED A VOICEMAIL LISTENING LINE IN FOUR 3 

DIFFERENT LANGUAGES. WE HAVE AN OFFICIAL COMMENT PERIOD FOR 4 

LETTERS AND E-MAILS STRETCHING THROUGH AUGUST 10TH AND A POLL. 5 

YOU WILL BE RECEIVING MANY FORMS OF OUTREACH FEEDBACK. WHEN IT 6 

COMES DOWN TO THIS, WHEN YOU SEE OUTCOMES THAT ARE NOT 7 

DESIRABLE, EQUITABLE OR RESILIENCE IT COMES DOWN TO MODIFYING 8 

STRATEGIES WE STARTED WITH, ADDING, REMOVING OR MODIFYING FOR 9 

THE FINAL BLUEPRINT AND WE LOOK FORWARD TO THE INPUT WE 10 

RECEIVE. WE HAVE STARTED THE PROCESS WHEN WE THINK ABOUT THE 11 

TRANSPORTATION ELEMENT THROUGH JEWEL AND JULY AND MORE WORK 12 

WILL CONTINUE TO BE DONE IN AUGUST. NEXT SLIDE. HERE ARE SOME 13 

OF THE UPCOMING MILESTONES. WE HOPE YOU CAN HELP US GET THE 14 

WORD OUT ABOUT THE DRAFT BLUEPRINT NEXT MONTH AS WE DO 15 

ENGAGEMENT ACROSS THE REGION IN A VIRTUAL MANNER AND WE'LL BE 16 

BACK IN SEPTEMBER WITH AN UPDATE AND PROPOSAL FOR STRATEGY 17 

REFINEMENTS AND REVISIONS FOR THE FINAL BLUEPRINT THIS FALL. 18 

NEXT SLIDE. THAT WRAPS UP THE PRESENTATION FOR TODAY. THERE IS 19 

LOTS IN INFORMATION ON PLANNEDBAYAREA.ORG/BLUEPRINT AND I AM 20 

HAPPY TO TAKE ANY QUESTIONS OR COMMENTS. THANK YOU.  21 

 22 

KAREN MITCHOFF, CHAIR: OKAY THERE. LET'S SEE. LET'S GO TO 23 

PARTICIPANTS. COME ON. ALL RIGHTY. I DON'T SEE ANY HANDS 24 
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RAISED. I CAN'T BELIEVE THERE IS NO HANDS RAISED. MAYOR 1 

ASHCRAFT. FIRST ONE UP. GO AHEAD PLEASE. UNMUTE YOURSELF.  2 

 3 

MARILYN EZZY ASHCRAFT: I'M TRYING. OKAY.  4 

 5 

KAREN MITCHOFF, CHAIR: YOU THERE GO.  6 

 7 

MARILYN EZZY ASHCRAFT: THANK YOU. THANK YOU. EXCELLENT 8 

PRESENTATION. THANK YOU. A LOT OF EXCITING MATERIAL IN THERE. 9 

THIS IS MY CONCERN AND PERHAPS OTHERS. SO YOU MENTIONED, MR. 10 

VAUTIN, THAT YOU DIDN'T LOOK SPECIFICALLY DIDN'T STUDY THE 11 

IMPACT OF COVID-19, BUT DECIDED THAT IT WOULD BE SIMILAR TO 12 

OTHER CYCLES OF BUST AND BOOM THAT THE BAY AREA HAS BEEN 13 

THROUGH, AS FAR AS IMPACT ON ECONOMIES. I WOULD URGE THAT 14 

THERE BE SPACE IN THIS STUDY, IN THESE FORECASTS FOR INPUT 15 

FROM PUBLIC HEALTH EXPERTS, IF THAT HASN'T BEEN DONE, AND LEER 16 

WE ARE IN THE SHADOW OF UCSF WHERE SOME OF THE TOP MEDICAL AND 17 

EPIDEMIOLOGICAL MINDS ARE STUDYING, AND CONSULTING ON COVID-18 

19. BECAUSE MY SENSE IS THAT WHILE THE COVID-19 PANDEMIC MAY 19 

BARE SIMILARITIES TO OTHER CRISES WE HAVE BEEN THROUGH, I 20 

THINK IN SOME WAYS THAT WE DON'T EVEN KNOW, IT IS VERY 21 

DIFFERENT. AND I AM CONCERNED THAT WE'RE LOOKING AT THE COVID-22 

19 RECESSION IMPACTS FROM 2030 AT THIS TIME WHEN WE ARE STILL 23 

IN THE FIRST WAVE OF THIS PANDEMIC, AND WE CERTAINLY DON'T 24 

HAVE IT UNDER CONTROL. I'M ALWAYS THE OPTIMIST, AND I BELIEVE 25 
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THAT TIME AND SCIENCE ARE ON OUR SIDE AND THAT WE'RE WORKING 1 

TOWARD -- OR SCIENCE IS WORKING TOWARDS BETTER THERAPEUTICS 2 

AND VACCINATIONS. BUT WE DON'T HAVE THEM YET. AND I DO THINK 3 

THAT THIS IS GOING TO CUT ACROSS SO MANY DIFFERENT THINGS. 4 

HOUSING, TRANSPORTATION, THE WAY WE WORK, SO I WOULD JUST URGE 5 

THAT WE GO TO EXPERTS WHO COULD ACTUALLY BRING SUBJECT MATTER 6 

EXPERTISE TO THESE FORECASTS. THANK YOU. >DAVE VAUTIN: THANKS 7 

FOR THAT COMMENT AND IF I COULD OFFER A BRIEF RESPONSE. WE'LL 8 

BE CONSULTING WITH LOTS OF DIFFERENT STAKEHOLDERS INCLUDING 9 

PUBLIC HEALTH STAKEHOLDERS OVER THE NEXT FEW MONTHS WE 10 

EXPLORED PAST PANDEMICS, THE 1919 PANDEMIC THAT HIT THE BAY 11 

AREA, THE SPANISH FLU. AND WE CAN GAIN INSIGHT TO IMPACTS AND 12 

HOW THE REGION CAN REBOUND FROM THE PANDEMIC. WE ARE 13 

DEVELOPING AN IMPLEMENTATION PLAN FOR THE NEXT FIVE YEAR AND 14 

THAT WILL HAVE FOCUS ON THE PANDEMIC BECAUSE THOSE IMPACTS 15 

WILL BE OBVIOUS IN THE NEXT FEW YEARS AND THAT WILL BE THIS 16 

FALL THERE IS A LOT OF WAYS WE CAN TRYING TO WEAVE COVID-19 17 

INTO THE PLAN.  18 

 19 

MARILYN EZZY ASHCRAFT: I'M GLAD YOU'RE LOOKING BACK AT THE 20 

SPANISH FLU EPIDEMIC. I HAVE FAMILY MEMBERS THAT WERE LOST IN 21 

THAT PANDEMIC, BUT I ALSO THINK THE BAY AREA WAS QUITE A 22 

DIFFERENT PLACE 103 YEARS AGO. SO YOU'RE PROBABLY PLANNING TO 23 

INCLUDE THIS, BUT I WOULD CERTAINLY LIKE A STUDY OR ANALYSIS 24 

OF HOW LONG IT WILL TAKE OUR PUBLIC TRANSIT SYSTEMS TO BE UP 25 
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AND RUNNING AGAIN. THOSE OF US WHO HAVE BEEN AT -- LIKE 1 

ALAMEDA COUNTY TRANSPORTATION COMMISSION MEETINGS AND OTHER 2 

PLACES HAVE HEARD SOME PRETTY DIRE, AS WE'RE HEARING AROUND 3 

THE REGION SOME PRETTY DIRE STATISTICS ABOUT HOW THESE SYSTEMS 4 

ARE BARELY HANGING ON. BUT, THANK YOU, IT -- I JUST URGE THAT 5 

BROADER LOOK. THANKS.  6 

 7 

KAREN MITCHOFF, CHAIR: THANK YOU MARILYN. PAT EKLUND.  8 

 9 

PAT ECKLUND: CAN YOU HEAR ME KAREN?  10 

 11 

KAREN MITCHOFF, CHAIR: YES. GO AHEAD.  12 

 13 

PAT ECKLUND: I HAVE QUESTIONS AND COMMENTS. DO YOU WANT ME TO 14 

DO THEM ALL AT THE SAME TIME?  15 

 16 

KAREN MITCHOFF, CHAIR: GO AHEAD.  17 

 18 

PAT ECKLUND: FIRST QUESTION IS, I THOUGHT WE WERE GOING TO DO 19 

A STRATEGY ON TELECOMMUTING AND I DIDN'T SEE IT IN THE 20 

LISTING. SHOULD I WAIT FOR THE SPONSOR GO AHEAD AND DO MY 21 

COMMENTS? >DAVE VAUTIN: I CAN --  22 

 23 

KAREN MITCHOFF, CHAIR: GO AHEAD AND RESPOND DAVE THEN SHE CAN 24 

MAKE HER COMMENTS.  25 
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 1 

PAT ECKLUND: OKAY THANK YOU. >DAVE VAUTIN: WE HAVE WORKED 2 

CLOSELY WITH THE AIR RESOURCES BOARD TO ACCELERATE THE 3 

ADOPTION OF TELECOMMUTING IT'S AN EXTERNAL FORCE AT THIS TIME, 4 

FOLKS TELECOMMUTING HOWEVER WE WANT TO THINK ABOUT ADDITIONAL 5 

STRATEGIES THAT CAN PUSH THAT FORCE EVEN HIGHER THAT'S ONE OF 6 

THE AREAS OF THE BLUEPRINT WILL FOCUS ON BUT THAT'S NOT A 7 

SILVER BULLET JUST BECAUSE FOLKS ARE WORKING FROM HOME DOESN'T 8 

MEAN THEY'RE NOT TAKING OTHER AUTOMOBILE TRIPS. THEY STILL 9 

CONTRIBUTE GHGS BUT IT'S ANOTHER PIECE OF THE PUZZLE.  10 

 11 

PAT ECKLUND: I THINK TELECOMMUTING IS GOING TO AFFECT MORE 12 

THAN JUST TRANSPORTATION. OR THE COMMUTING PATTERN. I THINK 13 

IT'S GOING TO AFFECT WHERE AND HOW MANY JOB SITES THERE ARE. 14 

AND I THINK IT'S GOING TO BE IMPACTING THINGS ALL OVER THE 15 

MAP. AND SO WE'RE, IN A WAY, GOING TO HAVE TO REDEFINE WHAT WE 16 

DEFINE AS A JOB. BECAUSE IT MAY NOT BE A PARTICULAR LOCATION. 17 

BUT I HAVE BEEN READING SOME OF THE COMMENT LETTERS, AND 18 

LISTENING TO A LOT OF THE PEOPLE COMMENTING, AND I HAVE TO 19 

AGREE WITH COMMENTS MADE ABOUT CONCERNS WHAT WE'RE INCLUDING 20 

IN HERE AS 1.5 MORE HOUSING UNITS AND 1.4 MILLION MORE JOBS. 21 

BECAUSE I THINK COVID HAS REALLY CHANGED OUR LIVES FOR THE 22 

FUTURE. AND I DON'T THINK WE'RE GOING TO BE GOING BACK TO 23 

WHERE WE WERE. AND IN FACT I WAS TALKING TO AN ECONOMIST 24 

YESTERDAY WHO IS PREDICTING THAT IT'S GOING TO TAKE A LOT 25 
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LONGER FOR US TO COME OUT OF THIS THAN WHAT WAS ORIGINALLY 1 

ANTICIPATED. MY CONCERN IS, IS THAT THE STRATEGIES REALLY 2 

FOCUS ON LOWER CLASS AND LOWEST AFFORDABILITY. I THINK THE 3 

MISSING MIDDLE HAS NEVER REALLY BEEN ADDRESSED. AND WHEN THE 4 

MISSING MIDDLE MOVED OUT, THEN I THINK THAT PROVIDES, YOU 5 

KNOW, MORE HOUSING FOR THE LOWER FOLKS WHEN THEY CAN MOVE UP, 6 

BUT WE NEED MORE MIDDLE -- MIDDLE HOUSING, YOU KNOW, FOR THE 7 

MISSING MIDDLE, IN MY OPINION. AND I HEARD THE COMMENT LAST 8 

TIME ABOUT TOLL LANES ON ALL THE FREEWAY LANES, AND I WAS 9 

SHOCKED TO SEE THAT IS ONE OF THE STRATEGIES. I CAN'T IMAGINE 10 

HAVING TO PAY A TOLL TO GO FIVE MILES ON THE FREEWAY TO GO 11 

HELP MY MOM. AND SO I -- IF THAT'S -- I DON'T THINK THAT'S 12 

GOING TO BE WELL ACCEPTED IF PEOPLE KNOW THAT IT'S IN THERE. 13 

AND I HAVE ASKED SEVERAL PEOPLE THAT HAVE BEEN FOLLOWING, THIS 14 

DID YOU SEE THAT STRATEGY AND THEIR ANSWER WAS NO. SO I AM 15 

CONCERNED ABOUT THAT. BECAUSE A LOT OF PEOPLE IN CALIFORNIA 16 

FEEL AS THOUGH THEY HAVE ALREADY PAID FOR THE FREEWAYS OR ARE 17 

PAYING IT THROUGH THEIR GAS TAXES OR THROUGH THEIR INCOME 18 

TAXES. I REALLY THINK THAT THERE IS AN ELEPHANT IN THE ROOM 19 

THAT WE HAVEN'T ADDRESSED AND I THINK I RAISED THIS ABOUT FIVE 20 

OR SIX YEARS AGO IS THAT THE BAY AREA HAS A SHARING CAPACITY 21 

FOR JOBS AND HOUSING AND PEOPLE BASICALLY. AND WHAT IS THAT 22 

CARING CAPACITY? I WOULDN'T HAVE A CLUE. I WOULDN'T KNOW HOW 23 

TO EVALUATE THAT. BUT THIS'S SOMETHING WE HAVE TO START 24 

LOOKING AT THAT BECAUSE YOU CAN'T KEEP GROWING AND GROWING AND 25 



July 16, 2020 

 37 

GROWING AT THAT LEVEL WITH THE REACHES OF WATER. FUNDING I 1 

THINK YOU'RE PROJECTING IS NOT ATTAIN BELIEVE. SO THE 400,000 2 

PERMANENT AFFORDABLE HOMES, THAT'S GOING TO TAKE A LOT OF 3 

MONEY. AND I REALLY DON'T KNOW WHERE THAT'S GOING TO COME 4 

FROM. AND I CONTINUE TO BE CONCERNED ABOUT THE HOUSING 5 

METHODOLOGIES SO FAR TO NOT USE THE DRAFT BLUEPRINT AS THE 6 

MEANS OF DISTRIBUTING THE RHNA, AND INSTEAD TO USE THE CURRENT 7 

PATTERNS OF 2019. AND I RAISED THIS QUESTION LAST TIME ABOUT 8 

AN ENVIRONMENTAL ANALYSIS AND WHAT THAT WOULD DO WITH OUR 9 

GREENHOUSE GAS PROJECTIONS AND WANTING TO MEET THE 19 PERCENT 10 

TARGET BUT THIS WOULD EXASPERATE THAT TARGET. I REALLY THINK 11 

WE NEED TO THINK ABOUT THAT MORE SO WE CAN HAVE THAT 12 

DISCUSSION AT THE HOUSING METHODOLOGY COMMITTEE, AND THIS 13 

COMMITTEE AS WELL AS THE ABAG EXECUTIVE BOARD. AND LASTLY, I 14 

THINK THERE IS TOO MUCH EMPHASIS ON HIGH RESOURCE AREAS. AND 15 

THOSE ARE MY COMMENTS. AND EVENTUALLY I'LL BE PUTTING SOME OF 16 

THESE IN WRITING.  17 

 18 

KAREN MITCHOFF, CHAIR: THANK YOU PAT. SUPERVISOR HAGGERTY, I 19 

SAW YOUR HAND RAISED, AND NOW IT'S NOT. DID YOU WANT TO NOT 20 

SPEAK AFTER ALL?  21 

 22 

DIR. SCOTT HAGGERTY: WELL, I WAS AFRAID I HAD ANOTHER STUPID 23 

QUESTION.  24 

 25 
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KAREN MITCHOFF, CHAIR: NO. YOU NEVER HAD STUPID QUESTIONS 1 

SCOTT. GO AHEAD PLEASE.  2 

 3 

DIR. SCOTT HAGGERTY: THE LAST ONE I ACCUSED SANTA CLARA OF 4 

BEING SAN JOAQUIN. MY EAST AND WEST AND NORTH AND SOUTH. I AM 5 

CONCERNED, DAVE, THERE IS COUNTLESS ARTICLES COMING OUT THAT 6 

THERE IS A LARGE POPULATION MOVING OUT NOW OF THE URBAN CORES 7 

AND INTO THE SUBURBAN -- I CAN'T THINK OF IT -- THE BLACK 8 

BROWN COMMUNITY ARE MOVING OUT TO BRENTWOOD AND BRENTWOOD 9 

SEEMED LIKE A 5,000 PERCENT INCREASE IN THE POPULATION MOVE 10 

AND SO I'M JUST CURIOUS, ARE WE CONCERNED AT ALL THAT THINGS 11 

ARE KIND OF CHANGING RAPIDLY? AND THE PLAN IS PRETTY. MUCH 12 

GOING TO BE OBSOLETE ONCE WE GET GOING? >DAVE VAUTIN: I THINK 13 

WE'RE CONCERNED ABOUT THE IMPACTS OF THE SHORT-TERM TRENDS, 14 

THEY COULD BE REFLECTIVE OF ACCELERATED DISPLACEMENT FROM OUR 15 

COMMUNITIES IN THE CENTER OF THE REGIONS THOSE ARE THINGS WE 16 

SHOULD ARE CONCERNED ABOUT. AT THE SAME TIME IT'S IMPORTANT TO 17 

REMEMBER THIS IS A 30 YEAR PLAN. AT SOME POINT THIS PANDEMIC 18 

WILL BE OVER, AND THERE WILL BE A PERIOD OF RECOVERY AND THE 19 

IMPACTS, WE'LL HAVE SIGNIFICANT IMPACTS IN THE NEAR TERM. OVER 20 

THE LONG-TERM WE FEEL THAT OUR COMMUNITIES ALL ACROSS THE 21 

REGION ARE ATTRACTIVE PLACES TO LIVE. THERE ARE MANY GREAT 22 

ATTRIBUTES OF OUR URBAN CENTERS. IT'S NOT JUST THE ACCESS TO 23 

JOBS. IT'S ALL THE AMENITIES, ARE THE CULTURAL INSTITUTIONS, 24 

UNIVERSITIES AND THE LIKE. THERE ARE STILL A LOT OF COMPELLING 25 
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REASONS LONG-TERM THAT OUR BIG CITIES SAN HOSE OAKLAND AND SAN 1 

FRANCISCO WILL BE ATTRACTIVE PLACES TO SETTLE IN THE FUTURE.  2 

 3 

DIR. SCOTT HAGGERTY: YOU AND I SHOULD GET TOGETHER IN ABOUT 4 

TEN YEARS NOW AND SEE WHO WAS RIGHT. I DON'T THINK THEY'RE 5 

COMING BACK. I SAW A HOUSE IN FREMONT THE OTHER DAY THAT SOLD 6 

FOR 1.2 MILLION. AND THAT HOUSE IS OVER 1200 SQUARES FEET, IF 7 

YOU MOVED IT OUT OF THE COUNTY IT WOULD BE IN THE $200,000 8 

RANGE. COST OF HOW MUCH PEOPLE ARE SPENDING ON HOUSING AND 9 

TRANSPORTATION HAS GONE DOWN, I THINK YOU SAID 48 PERCENT, 10 

OVER THE PLAN, BUT I THINK IF SOMEBODY CAN LOOK AT A HOUSING 11 

THEY CAN BUY-IN SAN JOAQUIN COUNTY THEY'RE NOT GOING TO STAY. 12 

THEY'RE GOING TO GO. AND THERE'S NOTHING WRONG WITH LIVING IN 13 

SAN JOAQUIN COUNTY. A LOT TO DO RECREATIONAL STUFF. I DON'T 14 

THINK THEY'RE COMING BACK.  15 

 16 

KAREN MITCHOFF, CHAIR: SONJA TRAUSS.  17 

 18 

SPEAKER: IT SOUNDS LIKE THERE IS A LOT OF PEOPLE BEING LIKE, 19 

OH WELL, I DON'T KNOW, MAYBE THE POPULATION IS GOING TO GO 20 

DOWN. I WOULD LIKE TO HEAR WHAT ARE THE -- HOW DO I SAY THIS? 21 

THERE IS A PHRASE, BETTER SAFE THAN SORRY. RIGHT? SO GIVEN 22 

THAT WE DON'T KNOW, WHAT IS THE BEST ERROR TO MAKE? LIKE, TO 23 

MY MIND, ANTICIPATING A LOT OF HOUSING NEED IS BETTER THAN 24 

ANTICIPATING NOT ENOUGH. BECAUSE IF WE ZONE FOR A LOT OF 25 
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HOUSING, SAY WE BUILD AN APARTMENT BUILDING HERE, HERE, AND 1 

HERE AND WHEN IT TURNS OUT WE DON'T NEED ALL THAT ZONING. 2 

OKAY. NO HARM DONE. IT JUST DOESN'T GET BUILT OUT. BUT WHEN WE 3 

ANTICIPATE THAT WE DON'T NEED VERY MUCH HOUSING AND SAY OH 4 

KEEP THAT AS A PARKING LOT OR SINGLE FAMILY HOUSE BUT THERE 5 

ARE PEOPLE WHO WANT TO BUILD A LOT OF HOUSING AND THEY CAN'T 6 

BECAUSE THE LAW IS IN THE WAY. THAT'S A PROBLEM. HEAR ALL 7 

THESE COMMENTS GOING OH WE MIGHT NOT HAVE THAT MUCH POPULATION 8 

GROWTH. WHAT'S HARM IN OVERESTIMATING POPULATION GROWTH? I 9 

ALSO WANT TO REALLY MAKE SURE THAT PEOPLE REALIZE, IT MIGHT BE 10 

THE CASE PEOPLE LEAVE BUT THAT DOESN'T MEAN THERE WON'T BE 11 

SOMEBODY TO REPLACE THEM. I CAME HERE IN 2011 THE ECONOMY WAS 12 

SORT OF BAD HERE BUT WAY WORSE THAN EVERYWHERE ELSE. WE'RE 13 

STILL GOING TO HAVE PEOPLE TO WANT TO COME. EVEN IF PEOPLE 14 

LEAVE AND DON'T COME BACK THEY WILL BE REPLACED. I WANT TO 15 

TALK ABOUT HOUSEHOLD PROJECTIONS BETWEEN EARLY APRIL AND THIS 16 

DRAFT. AND I FORGET, IT WAS APRIL 5TH OR 8TH, THE PRESENTATION 17 

THAT WAS GIVEN, AND THE PRESENTATION WAS GIVEN A FEW TIMES, 18 

THE 2030 HOUSEHOLD PROJECTIONS WAS 3.377 MILLION, IS THEN NOW 19 

OUR NEW PROJECTIONS FOR HOUSEHOLDS IN 2030 IS 3.21 MILLION, 20 

WHICH IS 167,000 FEWER HOUSEHOLDS. AND THE EARLIER HOUSEHOLD 21 

PROJECTIONS IMPLIED THAT WE NEEDED ABOUT 600,000 NEW 22 

HOUSEHOLDS, AND THE NEW HOUSEHOLD PROJECTIONS IMPLIES WE NEED 23 

ABOUT 430,000 NEW HOUSEHOLDS, WHICH IS A PRETTY BIG DROP. AND 24 

I DON'T -- I DON'T SEE WHY A RECESSION OR EVEN COVID WOULD 25 
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CAUSE SUCH A DRAMATIC DECREASE. AND I CAN'T HELP BUT NOTICE 1 

THAT THE EARLIER HOUSEHOLD PROJECTIONS MATCHED THE REGIONAL 2 

HOUSING NEEDS DETERMINATION THAT STAFF WAS TELLING PEOPLE THEY 3 

THOUGHT WE WERE GOING TO GET, AND THEN COINCIDENTLY, THE NEW 4 

HOUSEHOLD PROJECTIONS MEETS OUR NEW REGIONAL HOUSING NEEDS 5 

DETERMINATION. IT SEEMS ALL TO CONVENIENT AND NOT PARTICULARLY 6 

BELIEVABLE DROP BECAUSE IT SEEMS LIKE SO MANY.  7 

 8 

KAREN MITCHOFF, CHAIR: THANK YOU, SONJA. ANYTHING ELSE? SONJA? 9 

OKAY. SHE MUTED HERSELF. I'M GOING TO LOWER HER HAND. OKAY. 10 

NEYSA FILGOR. CAN YOU HEAR ME?  11 

 12 

NEYSA FILGOR: YES I CAN, THANKS CHAIR. DAVE, I WILL NOT REPEAT 13 

ALL THE QUESTIONS AND COMMENTS I MADE AT THE HMC MEETING LAST 14 

WEEK. BUT I DO HAVE A FOLLOW UP GOING BACK TO THE PROJECTIONS 15 

FOR SANTA CLARA COUNTY, SAN MATEO COUNTY, SAN FRANCISCO AND 16 

OAKLAND. I WAS ASKED THIS BY A COUPLE OF RESIDENTS, WHETHER OR 17 

NOT WE CAN GET THE DATA SUPPORTING THAT 41 PERCENT PROJECTIONS 18 

IN SANTA CLARA COUNTY? I DON'T KNOW IF THAT'S AVAILABLE FOR 19 

US. I KNOW WE'LL BE HAVING WORKSHOP SUPERVISOR OPPORTUNITIES 20 

FOR THE PUBLIC TO ATTEND AND COMMENT AND ASK THOSE QUESTIONS. 21 

BUT I THINK WE WOULD REALLY APPRECIATE IT. I REPRESENT THE 22 

CITY IN SANTA CLARA COUNTY SO AT A MINIMUM, WE WOULD LOVE TO 23 

SEE THE DATA THAT SUPPORTS THAT 41 PERCENT PROJECTIONS, WHAT 24 

YOU'RE RELYING ON, WHAT THE ASSUMPTIONS ARE BASED ON. BECAUSE 25 
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OF COURSE, WE DISAGREE. WE THINK IT'S TOO HIGH AND THERE ARE 1 

OTHER AREAS IN THE BAY AREA THAT SHOULD ARE HIGHER BASED ON 2 

WHAT WE HAVE SEEN OVER THE LAST FEW YEARS AND WHAT WE 3 

ANTICIPATE HAPPENING WITH COVID AND OTHER FACTORS. THANKS 4 

DAVE. >DAVE VAUTIN: THANKS FOR THAT QUESTION. I WANT TO 5 

PROVIDE A QUICK RESPONSE. THE ON OUR WEB SITE WE HAVE A BREAK 6 

DOWN OF GROWTH WITHIN EACH COUNTY WE ALSO HAVE A MAP THAT 7 

SHOWS KEY GROWTH AREAS WHICH ARE THE MAIN AREAS THAT 8 

ADDITIONAL HOUSING AND JOBS GROWTH IS OCCURRING SO YOU CAN SEE 9 

WHERE THOSE LOCATIONS ARE IN THE COUNTY. WE HAVE ALSO WORKED 10 

WITH LOCAL JURISDICTION TO REVIEW ALL THE INPUT DATA THAT 11 

EFFORT TOOK PLACE IN 2019 AND EARLY 2020 AND THERE IS 12 

OPPORTUNITY IN OFFICE HOURS FOR LOCAL JURISDICTIONS TO COME IN 13 

LOOK AT THE DATA LOOK UNDER THE HOOD AND GET AN UNDERSTANDING 14 

OF THE SORTS OF STRATEGIES THAT WERE APPLIED IN THEIR 15 

JURISDICTION THAT LEAD TO THE GROWTH PREDICTIONS. THOSE ARE 16 

DIFFERENT RESOURCES AND OPPORTUNITIES TO LEARN MORE. >DAVE 17 

VAUTIN: IS THAT WHAT YOU MENTIONED IS THAT ALSO ONLINE? >DAVE 18 

VAUTIN: YES THERE IS AN ONLINE TOOL FOR BASIS. BUT THE OFFICE 19 

HOURS OPPORTUNITIES ARE REALLY GREAT FOR OUR LOCAL 20 

JURISDICTION BECAUSE IT CAN BE HELPFUL TO COLLABORATE AND TAKE 21 

A LOOK AT THAT STUFF TOGETHER.  22 

 23 

NEYSA FILGOR: OKAY. THANK YOU.  24 

 25 
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KAREN MITCHOFF, CHAIR: OKAY. IS THAT ALL YOU HAD NEYSA?  1 

 2 

NEYSA FILGOR: YES. THANK YOU.  3 

 4 

KAREN MITCHOFF, CHAIR: OKAY. THEN WE'LL GO ON TO AMBER C.  5 

 6 

SPEAKER: THANK YOU. I WANT TO THANK STAFF. THIS HAS BEEN A 7 

LONG PROCESS AND A LOT OF WORK ON YOUR END. TWO QUESTIONS. 8 

FIRST, I KEEP COMING BACK TO THE GREENHOUSE GAS EMISSIONS 9 

GOALS AND HOW FAR AWAY WE ARE FROM MEETING THEM, AND I KNOW A 10 

BIG PORTION OF THAT YOU'RE LOOKING AT BEING DEALT WITH THE 11 

HOUSING JOBS LOCATIONS, BUT I CAN'T HELP BUT THINK THAT THERE 12 

MUST BE SOME WAY TO BE ABLE TO DELIVER THE TRANSPORTATION 13 

IMPROVEMENTS EARLIER. AND I THINK NEXT WEEK WE'LL BE TALKING -14 

- OR MTC COMMISSION WILL BE TALKING ABOUT HOW TO POTENTIALLY 15 

MOVE SOME OF THE PROJECTS FROM LATER IN THE PLAN TO EARLIER. 16 

SO WE WOULD JUST URGE THAT YOU STRONGLY CONSIDER THAT, AND 17 

MOVING THE REGIONAL MEGA MEASURE FUNDING INTO THE EARLIER 18 

PORTION OF THE PLAN IN ORDER TO START DELIVERING SOME OF THESE 19 

CRITICAL TRANSPORTATION PROJECTS EARLIER, AND HOPEFULLY 20 

INCREASE EVEN MORE THE ABILITY OF PEOPLE TO USE, ESPECIALLY 21 

THE NEW TRANSIT INVESTMENTS. ALSO, I WANTED TO COMMENT THAT WE 22 

REALLY APPRECIATE, IN THE STRATEGIES, THE KIND OF BROAD 23 

THINKING ABOUT SEAMLESSNESS, NOT JUST WITH RESPECT TO FARES, 24 

BUT ALSO LOOKING AT ACROSS MODES, SO TOLL LANES, TDM, RIDE-25 
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SHARE, AND THE EFFORTS THAT ARE GOING ON RIGHT NOW WITH 1 

SEAMLESS, THE PARTNERSHIP SEAMLESS SUBCOMMITTEE BLUE RIBBON 2 

TASK FORCE EXPRESS LANE STEERING COMMITTEE. WE URGE TO NOT 3 

JUST LOOK FOR OPPORTUNITIES WITHIN THE MODES BUT THEN ALSO 4 

KIND OF AN UMBRELLA OPPORTUNITY FOR SEAMLESSNESS THAT LOOKS AT 5 

THINGS LIKE TRANSIT SUBSIDIES FOR EXPRESS LANE USE. SO ACROSS 6 

SUBSIDIES WITH TRANSIT AND EXPRESS LANE USED COMBINED WITH 7 

MEANS BASE TOLLING IT CAN ADVANCE EQUITY GOALS THAT ARE A 8 

CRITICAL PART OF THIS PLAN AS WELL. SO THANK YOU.  9 

 10 

KAREN MITCHOFF, CHAIR: OKAY. THANK YOU VERY MUCH. LAST HAND 11 

RAISED I HAVE FROM OUR MEMBERS IS RICK BONILLA. IF THERE IS 12 

ANYONE ELSE WHO WISHES TO SHARE COMMENTS OR QUESTIONS PLEASE 13 

RAISE YOUR HAND. SONJA I'M GOING TO GO TO PUBLIC COMMENT 14 

FIRST. BECAUSE YOU HAVE ALREADY HAD YOUR TIME. RICK BONE ILLA, 15 

PLEASE.  16 

 17 

RICK BONILLA: THANK YOU MADAM CHAIR. I HAVE A COUPLE ON OF 18 

COMMENTS. ONE IS, I NOTICED WE'RE LOOKING AT JOBS AND HOUSING 19 

FIT, BUT YOU KNOW WE'RE PROJECTING, AND I FEEL GOOD ABOUT THE 20 

PROJECTIONS BUT WE'RE PROJECTING TO BUILD A LOT OF HOUSING IN 21 

THE NEXT CYCLE AND OVER THE SPAN OF 2050, THERE IS A SERIOUS -22 

- I COME FROM THE CONSTRUCTION INDUSTRY, I AM A RETIRED 23 

CARPENTER. I KNOW A LOT ABOUT THE CONSTRUCTION INDUSTRY, AND I 24 

CAN SPEAK TO THE FACT AND I BELIEVE A MEMBER OF THE PUBLIC 25 
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ALSO HONED IN ON THIS, THERE IS CLEARLY A SHORTAGE THAT'S 1 

HISTORICAL BUT IT'S MORE THAN JUST A SHORTAGE EVER SKILLED AND 2 

TRAINED WORKERS WHICH LEADS TO HIGHER COST LOWER PRODUCTIVITY 3 

AND SLOWER ACTUAL PRODUCTION OF HOUSING, BUT IT HAS TO DO WITH 4 

THE FACT THAT THE CURRENT TRAINED AND SKILLED WORKFORCE IS 5 

AGING. AND WE'RE NOT TAKING IN YOUNG PEOPLE BECAUSE THEY 6 

CLEARLY, AND THIS HAS BEEN STUDIED IN NEW SURVEYS VIEW THESE 7 

JOBS AS BEING TOO HARD. YOU WORK OUTSIDE. YOU DON'T ALWAYS 8 

HAVE GUARANTEED WORK BECAUSE THERE IS A SEASONAL NATURE. A 9 

WHOLE LIST OF IMPEDIMENTS TO ATTRACT YOUNG PEOPLE. I WANT TO 10 

PUT THIS BUG IN THE EAR, WE NEED TO FORM A COALITION WITH 11 

PEOPLE TO MAKE SURE WE'RE ABLE TO INDUCE PEOPLE TO SEEK 12 

TRAINING AND OPPORTUNITIES IN WHAT CAN BE A WELL PAYING JOB IN 13 

THE WORK OF CONSTRUCTION WORKERS TO VALUE PROPERLY AND IF 14 

THEY'RE PROVIDED WITH BENEFITS BECAUSE IT IS A DANGEROUS AND 15 

DIFFICULT JOB. THEY NEED HEALTH CARE, INDEED PENSION. ALL OF 16 

THESE THINGS NEED TO BE TAKEN INTO CONSIDERATION. I WANT TO 17 

ADD, RARDING TRANSPORTATION, I WANT TO ADD TO WHAT WAS SAID 18 

ABOUT TRYING TO MOVE UP THE SCHEDULE AND SEEK TO PUT 19 

TRANSPORTATION IMPROVEMENTS IN PLACE AS SOON AS POSSIBLE 20 

BECAUSE OF THE SEVERE ISSUE WE HAVE WITH GREENHOUSE GAS 21 

EMISSIONS, CLIMATE CHANGE, SEA LEVEL RISE, ALL OF THE OTHER 22 

ASSOCIATED FACTORS. I SERVE ON TWO COMMITTEES HERE IN SAN 23 

MATEO COUNTY WHERE WE'RE WORKING ON ALL OF THE ISSUES THAT 24 

WERE SPOKE ABOUT SUCH AS RIDE-SHARE AND SO FORTH, SHUTTLES, 25 
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GETTING PEOPLE ON TO THE TRAINS, SO YOU NAME T FINALLY, I WANT 1 

TO MENTION ONE LAST THING, WHICH IS THE INACTION, THE LACK OF 2 

SUPPORT THAT CAME FROM THE SAN FRANCISCO BOARD OF SUPERVISORS 3 

FOR CALTRAIN, THE OTHER DAY, IS JUST INEXPLICABLE TO ME. I 4 

HAVE AN ISSUE WITH IT. CALTRAIN IS THE ONLY MASS TRANSIT THAT 5 

SERVES ARE BETWEEN SAN FRANCISCO AND SAN JOSE, EVERYBODY ON 6 

THE PENINSULA ALL OF THE CITIES THAT BOARD THE TRACKS ARE 7 

BUILDING TRANSIT ORIENTED DEVELOPMENT ALL ALONG THOSE 8 

CORRIDORS. ALL OF OUR CLIENTS IN THE CITY OF SAN MATEO THAT I 9 

HAILED FROM ARE BUILT AROUND THE TRANSIT CORRIDOR, THE TRACKS. 10 

WE HAVE TO USE CALTRAIN. SO ANYBODY WHO CAN, PLEASE THINK 11 

ABOUT THIS, AND WORK TO URGE DECISION MAKERS TO VALUE AND 12 

SUPPORT MASS TRANSIT, ESPECIALLY RAIL TRANSIT LIKE CALTRAIN. 13 

OKAY. THANK YOU.  14 

 15 

KAREN MITCHOFF, CHAIR: THANK YOU. LET'S SEE. DO WE HAVE ANY 16 

PUBLIC COMMENT ON THIS, FRED? UPON  17 

 18 

CLERK OF THE BOARD: THERE ARE TWO MEMBERS OF THE PUBLIC WITH 19 

THEIR HAND RAISED. FIVE NOW.  20 

 21 

KAREN MITCHOFF, CHAIR: OKAY. WOULD YOU CALL ON OUR FIRST 22 

CALLER, PLEASE.  23 

 24 
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CLERK OF THE BOARD: TO CONFIRM, CHAIR, THE TWO MINUTE TIME 1 

LIMIT?  2 

 3 

KAREN MITCHOFF, CHAIR: YES PLEASE.  4 

 5 

CLERK OF THE BOARD: OUR FIRST SPEAKER IS RODNEY NICKENS. GO 6 

AHEAD RODNEY. RODNEY, UNMUTE YOURSELF, PLEASE.  7 

 8 

SPEAKER: AM I GOOD TO GO?  9 

 10 

CLERK OF THE BOARD: YES.  11 

 12 

SPEAKER: OKAY. THANK YOU FRED. SORRY ABOUT THAT. [LAUGHTER] 13 

GOOD AFTERNOON COMMITTEE MEMBERS. MY NAME IS RODNEY NICKENS, 14 

THE POLICY MANAGER AT THE NON-PROFIT HOUSING OCEAN OF NORTHERN 15 

CALIFORNIA. WE'RE BASED IN SAN FRANCISCO. AND FIRST I WANT TO 16 

THANK STAFF FOR ALL OF THEIR WORK ON PLANNED BAY AREA THUS 17 

FAR. WE KNOW THIS HAS BEEN A TREMENDOUS UNDERTAKING ESPECIALLY 18 

DURING THIS EMERGENCY. WE APPRECIATE ALL OF THE WORK THUS FAR 19 

AND ALL THE DISCUSSIONS THIS AFTERNOON. I AM PERSONALLY 20 

PLEASED TO SEE SUGGESTIONS PERTAINING TO PARTNERS HOUSING AND 21 

LANE STRATEGIES HAVE BEEN IMPLEMENTED IN THE PLAN AS MENG SAID 22 

BEFORE THESE STRATEGIES ARE IMPORTANT TO OUR HOUSING 23 

AFFORDABILITY RISE. THERE ARE GOING TO BE CRITICAL 24 

CONVERSATIONS HAPPENING IN THE NEXT FEW MONTHS ESPECIALLY 25 
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AROUND PLANNED BAY AREA AND RHNA AND ALL THE VARIOUS POLICY 1 

UPDATES AND PROGRAMS THAT MTC AND ABAG ARE ENGAGED IN AT THIS 2 

POINT. BUT I THINK IT'S CRITICAL THAT WE REFLECT ON THE 3 

FAILURES OF THE PREVIOUS PLAN TO ADDRESS AFFORDABILITY 4 

CHALLENGES AND THAT WE CONTINUE TO ENCOURAGE LOCAL 5 

JURISDICTION IN HIGH OPPORTUNITY AREAS TO THINK ABOUT HOW THEY 6 

ADDRESS THEIR FAIR SHARE OF HOUSING GROWTH AND THE HISTORIC 7 

AND LEGACY OF RACIAL INJUSTICE AND ECONOMIC INEQUITY THAT ARE 8 

DISPROPORTIONATELY IMPACTING THE AFRICAN AMERICAN COMMUNITY 9 

AND COMMUNITIES OF COLOR MORE BROADLY. I THINK IT'S IMPORTANT 10 

TO ADDRESS BUILDING PRACTICES IN THOSE COMMUNITIES AND PUT 11 

FORWARD BOLD STRATEGIES AND IDEAS AND POLICIES THAT WILL 12 

EXPAND THE WORK THAT HAS ALREADY BEEN DONE TO ADDRESS THE 13 

THREE PS, PROTECTIONS PRESERVATION, WE MUST DO MORE TO PROTECT 14 

OUR COMMUNITIES AND COMMUNITIES OF CONCERN. WE MUST DO MORE TO 15 

ADDRESS THOSE WHO ARE UNHOUSED. WE HAVE A SEVERE HOMELESSNESS 16 

CRISIS THAT'S EXACERBATED BY THE PANDEMIC IT'S INCUMBENT UPON 17 

ALL OF US, STAKEHOLDER SUPERVISOR OFFICIALS AS MEMBERS OF THE 18 

BODY TO TAKE THIS CHALLENGE SERIOUSLY AND RISE TO THE 19 

OCCASION. I WANT TO THANK YOU FOR THE HARD WORK YOU'RE DOING. 20 

WE RECOGNIZE THIS IS AN UNPRECEDENTED TIME. THANK YOU VERY 21 

MUCH.  22 

 23 

CLERK OF THE BOARD: THANK YOU. NEXT SPEAKER IS SAM DEUTSCHE, 24 

GO AHEAD.  25 
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 1 

SPEAKER: HI. TO THE COMMITTEE. MY NAME IS SAM D. THANKS FOR 2 

TAKING THE TIME TODAY. JUST TO GIVE SOME CONTEXT, I THINK IT'S 3 

VERY IMPORTANT TO LOOK AT THE BROADER SCOPE OF WHAT'S GOING ON 4 

IN THE BAY AREA RIGHT NOW, WHICH IS THAT WE ARE ONE OF THE 5 

MOST UNAFFORDABLE METROPOLITAN AREAS IN THE ENTIRE COUNTRY. 6 

AND THAT'S GOING TO HAVE EFFECTS FOR EVERYBODY THAT LIVES 7 

HERE. JUST SPEAKING PERSONALLY, I AM A RENTER, I HAVE THREE 8 

ROOMMATES, AND TO BE FRANK, I'M PROBABLY NEVER GOING TO BE 9 

ABLE TO AFFORD TO BUY A HOUSE IN THE BAY AREA WHICH IS 10 

FUNCTION OF THE POLICIES INCLUDING DISCRETIONARY ZONING THAT 11 

HAVE GOTTEN INTO THIS SITUATION WHERE WE HAVE SUCH A SEVERE 12 

HOUSING SHORTAGE. AND I WANT TO TELL ABAG THAT THERE IS NO 13 

REASON TO LOWER THE PROPOSED HOUSING PROJECTIONS BASED ON 14 

COVID, GIVEN HOW STRONG THE ECONOMY IS, IN GENERAL, IN THE BAY 15 

AREA, EVEN THOUGH DESPITE THE RECESSION THE BAY AREA IS ALWAYS 16 

GOING TO BE INCREDIBLY DESIRABLE DUE TO CONCENTRATION OF 17 

COMPANIES AND THE WEATHER AND THE NATURAL BEAUTY AS WELL AND I 18 

THINK WE NEED TO STOP LOOKING AT THE STATUS QUO AS SOMEWHAT 19 

ACCEPTABLE AND START THINKING MORE RADICALLY ABOUT MASSIVELY 20 

INCREASING THE NUMBER OF HOUSINGS THAT WE BUILD TO INCREASE 21 

ECONOMIC OPPORTUNITY BUT ALSO TO CREATE A MORE SUSTAINABLE 22 

ENVIRONMENT, BOTH IN TERMS OF THE FACT THAT THE BAY AREA'S 23 

AMAZING WEATHER AND THE PEOPLE DON'T NEED TO SPEND AS MUCH 24 

ENERGY HEATING THEIR HOMES BUT ALSO THINKING ABOUT TRANSIT 25 
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CONCENTRATION AND HOUSING NEAR MASS TRANSIT WHERE PEOPLE WILL 1 

HAVE EASY ACCESS TO JOBS, THEY WON'T HAVE TO SPEND THOUSANDS 2 

OF DOLLARS ON CARS, BALLS -- BUT ALSO WILL NOT CONTRIBUTE TO 3 

GLOBAL WARMING AND CONGESTION. THANK YOU.  4 

 5 

CLERK OF THE BOARD: NEXT SPEAKER IS SCOTT LITTLEHALE. UNMUTE 6 

YOURSELF PLEASE.  7 

 8 

SPEAKER: GOOD AFTERNOON. THANK YOU FOR ALLOWING PARTICIPATION. 9 

MY NAME IS SCOTT. I APPRECIATED HEARING THE PRESENTATION. I 10 

ALSO APPRECIATED COUNCILMEMBER BONILLA, I WANT TO ELABORATE ON 11 

THIS. IN MY INITIAL INVOLVEMENT IN THE HOUSING METHODOLOGY 12 

COMMITTEE, I NOTICED THERE WAS GOING TO BE A SURVEY OF LOCAL 13 

JURISDICTION ABOUT BARRIERS TO ATTAINING OUR HOUSING NEEDS, 14 

AND NOTICED THAT WHILE THERE ARE QUESTIONS RELATING TO 15 

AVAILABILITY OF CAPITAL, AVAILABILITY OF LAND, THERE WAS NO 16 

QUESTION ABOUT AVAILABILITY OF LABOR TO BUILD HOUSING. WE -- 17 

FORTUNATELY STAFF LISTENED, INCLUDED THE QUESTION ON THE 18 

SURVEY AND IT CAME BACK AS THE FOURTH MOST COMMON RESPONSE OF 19 

BEING A SERIOUS BARRIER TO ATTAINING AND ACHIEVING OUR HOUSING 20 

NEEDS BUILD-OUT. NOW, WHY DO WE HAVE PROBLEMS WITH LABOR? 21 

WELL, I HAVE DONE SOME WORK WITH THE AMERICAN COMMUNITY 22 

SURVEY, AND IT TURNS OUT THAT FOUR OUT OF TEN CONSTRUCTION 23 

WORKER FAMILIES LIVING IN WEST BAY, EAST BAY, AND SOUTH BAY 24 

QUALIFY AS VERY LOW INCOME FAMILIES. SO YOU'RE GOING TO HAVE 25 
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DIFFICULTY DOUBLING THE SIZE OF YOUR CONSTRUCTION WORKFORCE 1 

FOR BUILDING HOUSING, HOUSING TYPICALLY PAYS LESS THAN IF YOU 2 

ARE BUILDING COMMERCIAL STRUCTURES OR PUBLIC WORKS, TO DOUBLE 3 

IT'S GOING TO BE VERY DIFFICULT IF YOU HAVE A BUNCH OF VERY 4 

LOW INCOME FAMILIES BECAUSE WHO WANTS TO TAKE ON A CAREER AND 5 

BE VERY LOW INCOME IN THE BAY AREA? PRESENTLY 1/3 OF HIRES 6 

EMPLOYING TO EMPLOYMENT AND CONSTRUCTION ARE ACKNOWLEDGE FROM 7 

OUTSIDE -- COMING FROM OUTSIDE THE BAY AREA. I ASK THAT WE 8 

MEASURE THESE ISSUES BECAUSE IF WE DON'T MEASURE THEM WE'RE 9 

GOT GOING TO SOLVE THE PROBLEM. THANK YOU VERY MUCH.  10 

 11 

CLERK OF THE BOARD: THANK YOU. NEXT SPEAKER IS CALLER WITH 12 

NUMBER ENDING IN 6187.  13 

 14 

SPEAKER: GOOD AFTERNOON ABAG MY NAME IS SARAH OGILVIE. I AM A 15 

RESIDENT IN SAN FRANCISCO. I CURRENTLY LIVE IN THE MISSION, IN 16 

MY ZIP CODE WE'RE EXPERIENCING THE WORST EFFECTS OF THE COVID-17 

19 PANDEMIC BUT A MAJOR SYMPTOM OF THESE EFFECTS IS THE 18 

OVERCROWDING. IT'S THE OVERCROWDING THAT I HAVE PERSONALLY 19 

WITNESSED AND I AM DEEPLY CONCERNED ABOUT ADDRESSING. I AM 20 

CONCERNED THAT LOWERING EXPECTATIONS FOR SENSITIVE COMMUNITIES 21 

IS REALLY GOING TO EXACERBATE THE PROBLEM. AND I'M JUST REALLY 22 

CONCERNED THAT THIS OVERALL REDUCTION IN THE NUMBERS IS BEING 23 

EXPRESSED AS A PROBLEM OF COVID-19. THERE WAS A JOHN HOPS 24 

CONSISTENCY STUDY PUBLISHED ON JUNE 19TH SAYING NOT LINKED TO 25 
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HIGHER CORONAVIRUS RAISED AND IS LINKED TO COVID-19 DEATH 1 

RATES. I'M ASKING ABAG TO REALLY CONSIDER THE NEED FOR HEALTHY 2 

DENSITY, ESPECIALLY IN AREAS LIKE MY DISTRICT TO BE PLANNED 3 

AND DEVELOPED IF POSSIBLE. AND THAT, YOU KNOW, AS FAR AS 4 

COUNCILMEMBER EKLUND'S COMMENTED, I BELIEVE THERE IS SOME 5 

MISSING MIDDLE HOUSING GOING ON HERE AND LET'S KEEP IN MIND 6 

THAT THE MARKET RATE HOUSING IS GOING TO BE THE KEY TO 7 

BUILDING MORE AFFORDABLE HOUSING. SO WE'RE GOING TO NEED AN 8 

ABUNDANCE OF BOTH TO ADDRESS THE HOUSING PROBLEMS IN THE 9 

REGION. AND I AGREE THERE NEEDS TO BE A CONSIDERATION OF 10 

LOOKING FOR MORE, EXPECTING MORE FROM THE BAY AREA, BECAUSE 11 

THE BAY AREA IS GOING TO BE A KEY LOCATION WHERE WE'RE GOING 12 

TO ACTUALLY SOLVE THE ECONOMIC CRISIS THAT HAS BEEN CAUSED BY 13 

THIS PANDEMIC. THERE ARE PROBLEMS. EVERYBODY CAN WORK TO MAKE 14 

THE BAY AREA BETTER. THANK YOU.  15 

 16 

CLERK OF THE BOARD: NEXT SPEAKER IS ALFRED TWU. GO AHEAD. 17 

UNMUTE YOURSELF PLEASE.  18 

 19 

KAREN MITCHOFF, CHAIR: FRED, HOW MANY MORE SPEAKERS DO WE 20 

HAVE?  21 

 22 

CLERK OF THE BOARD: THREE AFTER THIS ONE.  23 

 24 
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KAREN MITCHOFF, CHAIR: OKAY. SO WE HAVE FOUR SPEAKERS. MY 1 

CONCERN IS, WE HAVE TWO MORE CRITICAL ISSUES WE NEED TO GET 2 

TO, AND I KNOW WE NEED TO TAKE PUBLIC COMMENT. I WANT TO GIVE 3 

HEADS UP TO MR. SHORETT, MS. FASINGER. AND ADAMS. WE ONLY HAVE 4 

A HALF AN HOUR AND THE HOUSING COMMITTEE IS SUPPOSED TO MEET 5 

AFTER THIS. AM I CORRECT?  6 

 7 

JESSE ARREGUIN: THE HOUSING COMMITTEE MEETING IS AT 4:15.  8 

 9 

SPEAKER: THE TWO ITEMS FOLLOWING THIS ARE NOT LONG 10 

PRESENTATIONS. HOPE IS THEY WON'T TAKE A LOT OF TIME.  11 

 12 

KAREN MITCHOFF, CHAIR: THAT'S WONDERFUL. FRED GO AHEAD WITH 13 

OUR NEXT PUBLIC SPEAKER.  14 

 15 

SPEAKER: I'M ALFRED I LIVE IN EAST BERKELEY AND ONE OF THE 16 

THINGS I HAVE NOTICED IN THE LAST FEW MONTHS IS EVEN THOUGH 17 

PEOPLE ARE MOVING FROM SAN FRANCISCO TO FIND CHEAPER RENTED, 18 

THEY'RE NOT LEAVING THE BAY AREA, THEY'RE COMING TO THE EAST 19 

BAY AND WE'RE STILL SEEING OVERCROWDING AND HIGH HOUSING 20 

PRICES HERE. SO FOR THAT REASON, I URGE YOU TO AIM FOR A 21 

HIGHER NUMBER. THE WAY I THINK ABOUT IT IS IF YOU PUT IN THE 22 

HIGHER NUMBER AS THE GOAL AND IT ENDS UP BEING TOO HIGH, THERE 23 

IS NOT REALLY ANY CONSEQUENCE BECAUSE IT'S NOT LIKE HOMES ARE 24 

GOING TO BE BUILT WHERE THERE IS NO DEMAND BUT YOU IF YOU PUT 25 
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IN TOO LOW A NUMBER AND IT'S NOT ENOUGH THEN WE'RE BACK TO THE 1 

CONTINUOUS PROBLEM WE'RE HAVING WITH OVERCROWDING AND PEOPLE 2 

BEING DISPLACED IN THE AREA. AND THERE ARE A LOT OF PEOPLE I 3 

KNOW WHO USED TO LIVE IN THE BAY AREA WHO HAD TO MOVE AWAY BUT 4 

WANT TO MOVE BACK. SHOULD BE INCLUDED TO CALCULATE HOW MANY 5 

HOMES WE NEED IN THE REGION. THANK YOU.  6 

 7 

CLERK OF THE BOARD: NEXT SPEAKER IS KENNETH RUSSELL.  8 

 9 

SPEAKER: THANK YOU. GOOD AFTERNOON ABAG MY NAME IS KENNETH R. 10 

I LIVE IN SAN FRANCISCO. WHERE IS OUR VISION? IS OUR LEADERS 11 

OF THE BAY AREA SHOULD NOT BE SATISFIED WITH MINE ARE TWEAKS 12 

TO THE STATUS QUO. DO WE ALL THINK THINGS ARE WORKING FOR THE 13 

PEOPLE HERE? WE NEED TO PLAN FOR WHAT WE WANT TO HAPPEN. THIS 14 

PLAN SHOULDN'T BE A BARE MINIMUM JUST SCRAPING BY NOT MEETING 15 

OUR CLIMATE GREENHOUSE GAS GOALS. IT'S JUST TOO HARD, SO WE 16 

GIVE UP PLAN. LEADERSHIP ISN'T ABOUT EVERYTHING BEING EASY. 17 

THIS MOMENT ASKS A LOT OF OUR LEADERS. THAT'S WHY YOU ARE 18 

HERE. I ALSO THINK IT'S CRAZY THAT WE HAVE GROUPS HERE DURING 19 

THIS RECESSION TALKING ABOUT HOW THEY DON'T WANT PEOPLE AND 20 

TAXPAYERS. HOW MANY CITIES IN THE REGION ACROSS OUR COUNTRY 21 

WOULD BE HAPPY TO HAVE THE CHALLENGES WE HAVE HERE IN THE BAY 22 

AREA WITH MORE PEOPLE WANTING TO LIVE HERE? I ALSO THINK IT'S 23 

VERY CONCERNING THAT IN EARLY APRIL BEFORE THE REGIONAL 24 

HOUSING NEEDS DETERMINATION CAME OUT THE PLANNED BAY AREA 25 
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PROTECTION OF HOMES IS DOWN TO 3.21 MILLION. WHAT HAPPENED TO 1 

THE 167,000 HOUSEHOLDS. WE NEED TO AIM FOR THE FUTURE WE NEED 2 

AND THAT MEANS FIXING OUR UNAFFORDABILITY AND FIXING 3 

EXCLUSIONARY ZONING. PLEASE PLAN FOR THIS FUTURE WE NEED. LIKE 4 

ALFRED SAID, THE RISK ISN'T IN PLANNING FOR TOO FEW HOMES. 5 

RISK IS IN PLANNING FOR TOO MUCH. THANK YOU.  6 

 7 

CLERK OF THE BOARD: THANK YOU. NEXT SPEAKER IS THEO GORDON.  8 

 9 

SPEAKER: HELLO. MY NAME IS THEO GORDON. I AM A RENTER IN SAN 10 

FRANCISCO AND CHAIR OF SAN FRANCISCO YIMBY CALLING TO 11 

REPRESENT OUR 9,000 MEMBERS AND ASK THAT WE RAISE THE RHNA 12 

NUMBERS. WE'RE IN A HOUSING CRISIS. WE ALL KNOW THIS. WE HAVE 13 

ALL SEEN, AND THAT CRISIS HAS BEEN CAUSED BY LOCAL LEADERS WHO 14 

HAVE FAILED US. AND YOU KNOW THAT OUR GLOBAL LEADERS ARE 15 

FAILING US BECAUSE WE SAW TWO STORIES TO SPEAK OF IT IN SAN 16 

FRANCISCO THAT WAS DISCUSSED EARLIER IN THIS CALL BECAUSE OF A 17 

PETTY SQUABBLE AMONGST BOARD OF SUPERVISORS AND CALTRAIN A 18 

VITAL LINK IN THE BAY AREA THEY'RE ALSO ABOUT TO KILL SEVERAL 19 

THOUSAND HOMES IN THE PLAN ON MARKET STREET INCLUDING 25 20 

PERCENT BELOW MARKET RATE. THESE ARE OUR ELECTED OFFICIALS. 21 

THEY RESPOND TO PAROCHIAL CONCERNS AND THEY CAUSE THIS CRISIS. 22 

THEY SAY THEY WANT MORE HOUSING BUT THEN THEY BLOCK THAT 23 

HOUSING AND THEY PROFIT OFF OF THEIR OWN HOME VALUES. PLEASE 24 

TAKE AWAY OUR LOCAL CONTROL HOLD US ACCOUNTABLE TELL SAN 25 
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FRANCISCO YOU HAVE TO BUILD MORE HOUSING. THAT'S THE POWER YOU 1 

V MAKE GOVERNMENTS LIKE OURS GOVERNMENTS THAT ARE FAILING DO 2 

THEIR PART FOR FAIR HOUSING. RAISE THE NUMBER AND PUSH THE 3 

ALLOCATION INTO HIGH OPPORTUNITY AREAS LIKE SAN FRANCISCO. 4 

THANK YOU.  5 

 6 

CLERK OF THE BOARD: THANK YOU. NEXT SPEAKER IS JORDAN -- 7 

SORRY. ROBERT FRUCKMAN.  8 

 9 

SPEAKER: GOOD AFTERNOON MY NAME IS ROBERT F. I LIVE IN SAN 10 

FRANCISCO. I ALSO WANT TO CALL FOR MORE HOUSING IN SAN 11 

FRANCISCO. I WANT -- SO I HAVE BEEN DOING IN RESEARCH ON THE 12 

HOUSING DEFICIT FOR SAN FRANCISCO, IN PARTICULAR, I FOUND THAT 13 

SINCE 1970, WE HAVE ADDED 383,000 JOBS, BUT ONLY 57,000 HOMES. 14 

THAT'S A RATIO OF 6.6 JOBS PER HOME FOR THE LAST 50 YEARS. SO 15 

IT'S NOT SURPRISING THAT SAN FRANCISCO IS SO UNAFFORDABLE. 16 

ESPECIALLY TO INDUSTRIES WHERE YOU USED TO BE ABLE TO BE A 17 

BLUE-COLLAR WORKER AND LIVE IN SAN FRANCISCO. NOW IT'S JUST 18 

UNAFFORDABLE. IN 1968, THE HCD DIRECTOR CHARLES LEMENGER SAID 19 

THAT WE WOULD NEED 7.5 MILLION HOMES BY 2,000 TO ACCOMMODATE A 20 

POPULATION OF 40 MILLION PEOPLE. WE NEED TO BUILD AROUND 21 

250,000 HOMES PER YEAR. BUT WE HAVEN'T -- IN FACT, WE HAVE 22 

ONLY BUILT HALF OF THAT ACCORDING TO CALIFORNIA STATE REPORTS. 23 

SO AS A RESULT, WE DO NOT GET 40 MILLION PEOPLE IN THE YEAR 24 

2,000, WE HIT 33 MILLION. SO WHEN YOU DO NOT BUILD HOUSING IT 25 
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IS A SELF FULFILLING PROPHECY YOU LOWER YOUR POTENTIAL 1 

POPULATION AND YOU MAY GET UNAFFORDABLE FOR THE PEOPLE WHO ARE 2 

TRYING TO LIVE IN URBAN REGIONS. I URGE YOU TO MAKE SAN 3 

FRANCISCO MORE EQUITABLE AND AFFORDABLE BY ADDING TO OUR RHNA 4 

PROJECTIONS. THANK YOU.  5 

 6 

KAREN MITCHOFF, CHAIR: THANK YOU.  7 

 8 

CLERK OF THE BOARD: NEXT SPEAKER IS JORDAN GRIMES. GO AHEAD.  9 

 10 

SPEAKER: HI. GOOD AFTERNOON EVERYONE. THANK YOU FOR YOUR TIME. 11 

MY NAME IS JORDAN GRIMES. I AM A LIFE-LONG SAN MATEO RESIDENT 12 

AND LEAD MEMBER OF HOUSING ADVOCACY GROUP PENINSULA FOR 13 

EVERYONE. I WANT TO ECHO DIRECTOR ASHCRAFT'S COMMENTS AND 14 

DIRECTOR BONILLA'S COMMENTS -- EXCUSE ME, AND COUNCILMEMBER 15 

ASHCRAFT AND BONILLA'S COMMENTS. THIS ISN'T A NORMAL 16 

RECESSION. NEED FOR HOUSING IS NOT GOING AWAY AND IN FACT IT'S 17 

GREATER THAN EVER DUE TO WHAT WILL ALMOST ASSUREDLY BE AN 18 

INTENDED WAVE OF EVICTIONS COMING OVER THE NEXT SEVERAL 19 

MONTHS. I THINK IT'S INCREDIBLY IMPORTANT THAT WE HAVE A 20 

PUBLIC HEALTH ANALYSIS, A ROBUST PUBLIC HEALTH ANALYSIS 21 

INVOLVED BEFORE WE -- INVOLVED IN ASSESSING WHAT THE COVID 22 

IMPACTS ARE GOING TO BE ON HOUSING BEFORE WE MAKE ANY 23 

DECISIONS. WE'RE ALSO DECADES BEHIND ON OUR HOUSING GOALS AND 24 

WHO'S GOALS HAVE BEEN ABSURDLY INADEQUATE. IN NEW AREA BETWEEN 25 
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2010 AND 2017 MOUNTAIN VIEW ADDED A GRAND TOTAL OF 30,000 JOBS 1 

AGAINST A RHNA GOAL OF 2900 HOMES. MENLO PARK SIMILARLY ADDED 2 

19,000 JOBS AGAINST A RHNA GOAL OF 655 HOMES. SO YOU HAVE ALL 3 

OF THESE WEALTHY LOCALS THAT HAVE BEEN GOBBLING UP JOBS FOR 4 

THE LAST 20, 30 YEARS, AND THE RHNA GOALS HAVEN'T BEEN 5 

ANYWHERE NEAR WHAT THEY HAVE NEEDED TO BE. I DO WANT TO 6 

ADDRESS A COUPLE OF THE COMMENTS AROUND SPECIFICALLY 7 

TELECOMMUTING. I'M A LITTLE TIRED QUITE FRANKLY HEARING 8 

RETIREES PONTIFICATING ABOUT HOW TELECOMMUTING IS GOING TO 9 

SAVE US, WHEN MOST OF THEM, IF NOT THE GREAT MAJORITY OF THEM 10 

ARE NOT DEALING WITH TELECOMMUTING EVERY DAY. I THINK THERE IS 11 

A CONCERNING OVEREMPHASIS ON THAT. IT'S NOT GOING TO SAVE US. 12 

THANK YOU.  13 

 14 

CLERK OF THE BOARD: CHAIR MITCHOFF TWO ADDITIONAL MEMBERS OF 15 

THE PUBLIC RAISED THEIR HANDS TO SPEAK.  16 

 17 

KAREN MITCHOFF, CHAIR: GO AHEAD PLEASE.  18 

 19 

CLERK OF THE BOARD: NEXT SPEAKER IS REILLY E, GO AHEAD.  20 

 21 

SPEAKER: WE'RE AT THE BOTTOM OF A HOLE. WE HAVE BEEN DIGGING 22 

THE HOLE WITH EXCLUSIONARY ZONING, DISCRETIONARY REFUSE RHNA 23 

IS A TOOL THAT CAN HELP US TAKE LARGE STEPS OUT OF THIS CRISIS 24 

AND WE SHOULD BE USING IT TO BE AS BIG AND BOLD AS WE K I WANT 25 
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TO STAY IN THE BAY AREA BUT REGIONAL LOCAL AND STATE 1 

GOVERNMENTS TELLS ME YOU DON'T WANT ME HERE. PLEASE RAISE THE 2 

NUMBERS DRAMATICALLY. HELP US BUILD MORE HOUSING THROUGHOUT 3 

THE BAY AREA HELP US STOP DIG SUPPORTING FIX THE PROBLEMS WE 4 

HAVE CREATED FOR OURSELVES. THANK YOU.  5 

 6 

CLERK OF THE BOARD: THANK YOU. THAT'S OUR LAST SPEAKER. CHAIR 7 

MITCHOFF THERE WAS AN E-MAIL SENT LATE ON A NON-SPECIFIC 8 

AGENDA ITEM AND THAT WAS SENT TO ALL COMMITTEE MEMBERS.  9 

 10 

KAREN MITCHOFF, CHAIR: I DID SEE THAT. THANK YOU VERY MUCH. I 11 

SEE THAT CINDY CHAVEZ WOULD LIKE TO MAKE A COMMENTED. GO 12 

AHEAD.  13 

 14 

CINDY CHAVEZ: THANK YOU. I WANT TO LIFT UP ONE OF THE ISSUES 15 

THAT WAS RAISED BY SCOTT LITTLEHALE. AND I DO THINK THAT ONE 16 

OF THE CONSIDERATIONS, AS WE KEEP DOING THESE PLANS IS REALLY 17 

LOOKING AT OPPORTUNITIES TO MAKE SURE THAT WE'RE -- AS WE'RE 18 

SOLVING ONE PROBLEM WE'RE NOT CREATING ANOTHER. AND WHAT I 19 

MEAN BY THAT IS HAVING PEOPLE PAID SO LITTLE THAT THEIR 20 

COMMUTES ARE LONGER, AND THAT THEY'RE NEEDING PUBLIC 21 

ASSISTANCE. IT JUST SEEMS LIKE THAT DOESN'T TEAM IN TO BE A 22 

ZERO SUM GAME AND WE CAN THINK MORE CRITICALLY ABOUT THAT IN 23 

OUR PLANNING. THANK YOU.  24 

 25 
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KAREN MITCHOFF, CHAIR: THANK YOU. AND MATT, I'M GOING TO COME 1 

BACK TO YOU, BECAUSE SONJA HAS TEXTED THAT. SEE WOULD LIKE HER 2 

QUESTIONS ANSWERED. I'M NOT SURE -- THE FIRST ONE CAN BE 3 

ANSWERED. CAN YOU TALK ABOUT WHY THERE WAS A 11 LESSENING OF 4 

HOUSEHOLDS BY 167,000?  5 

 6 

MATT MALONEY: I THINK DAVE HAS GOT IT.  7 

 8 

KAREN MITCHOFF, CHAIR: AND THE SECOND IS PHILOSOPHICAL, WHAT 9 

ARE THE MEANS FOR UNDER OR OVERESTIMATING. I THINK YOU AND I 10 

HAD A CONVERSATION ABOUT THESE NUMBERS. CAN YOU ADDRESS THAT? 11 

>DAVE VAUTIN: I WOULD BE HAPPY TO ANSWER THE QUESTIONS. FIRST 12 

OF ALL I WANT TO NOTE WE BROUGHT FORWARD REGION GROWTH 13 

FORECAST IN APRIL RECOGNIZING IMPACTS OF JOB TRENDS AND 14 

SECONDARY IMPACTS ON POPULATION AND HOUSING DURING THE 2020S. 15 

TOTAL NUMBER OF NEW HOMES IN PLANNED BAY AREA 2050 IS 16 

CONSISTENT BETWEEN THE APRIL FORECAST AND THE JULY FORECAST 17 

THAT INCORPORATES ALSO OF THE COVID IMPACTS 1.5 MILLION NEW 18 

HOMES THROUGH 2050 WHICH IS A SIGNIFICANT INCREASE FROM OUR 19 

PREVIOUS PLAN AND THAT'S HELPING TO IMPROVE SOME OF THE 20 

HOUSING OUTCOMES. WITH REGARDS TO THE NEAR TERM IMPACT FOR THE 21 

YEAR 2030 THE REGION HAD 2.7 MILLION HOUSEHOLDS AND HOUSING 22 

UNIT IN 2015, AND THE 2030 NUMBERS WENT DOWN A LITTLE BIT LESS 23 

THAN THE COMMENTER BROUGHT UP. JUST TO GIVE THE NUMBERS FOR 24 

CONTEXT. WE HAD HOUSING HOLDS THAT WENT DOWN TO 3.2 AND 25 
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HOUSING WENT DOWN TO 3.3. THAT'S A REFLECTION OF THE WEAKER 1 

JOB GROWTH AND SLOWER POPULATION GROWTH IN THE 2020S BUT AS 2 

THE ECONOMY RECOVERS IN THE LATTER HALF OF 2020 AND BEYOND 3 

WE'RE SEE SUGGEST HOUSING DEVELOPMENT IN THE COMING YEARS SO 4 

WE'RE SEEING SLOW DOWN IN THAT PART OF THE PLAN. IN RELATION 5 

TO COVID JOBS HOUSING BALANCE IS RESPONSIVE TO WHAT WE HEARD 6 

FROM THE ABAG BOARD IN PROBLEM.  7 

 8 

KAREN MITCHOFF, CHAIR: THANK YOU VERY MUCH. >DAVE VAUTIN: ON 9 

THE SECOND QUESTION, BRIEFLY. WE EXPLORED THIS VERY QUESTION 10 

IN THE HORIZON INITIATIVE. AND IT IS TRUE THAT OUR HOUSING 11 

STRATEGIES PROVE EFFECTIVE IN BOTH THE WEAK AND STRONG MARKET 12 

ECONOMIES SO BY PROVIDING ADDITIONAL ZONING CAPACITY THE 13 

POSITIVES ARE MUCH GREATER THAN THE NEGATIVES BECAUSE IT WON'T 14 

NECESSARILY END UP BEING USED -- HOUSING MARKET INCOME LEVELS 15 

IF THE MARKET IS STRONG. THERE IS MORE INFORMATION ON THAT IN 16 

OUR FUTURES FINAL REPORT.  17 

 18 

KAREN MITCHOFF, CHAIR: THANK YOU VERY MUCH. I DON'T SEE ANY 19 

MORE HANDS RAISED. AND NO MORE PUBLIC COMMENT. SO WE'RE GOING 20 

TO MOVE ON.  21 

 22 

CLERK OF THE BOARD: CARLOS ROMERO WITH HIS HAND RAISED. AND 23 

THERE WAS ANOTHER PUBLIC SPEAKER THEY FAILED TO CALL ON. ALSO 24 

MARK.  25 
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 1 

KAREN MITCHOFF, CHAIR: I SEE MARK THERE. WHY DON'T WE TAKE THE 2 

PUBLIC SPEAKER FIRST.  3 

 4 

CLERK OF THE BOARD: KYLE KELLY, GO AHEAD.  5 

 6 

SPEAKER: HI THERE. I'M ACTUALLY CALLING FROM SANTA CRUZ. YOU 7 

HAVE PROBABLY HEARD ME SPEAK IN THE PAST. I WANT TO SPEAK TO 8 

SOME OF THE COMMUNITIES DOWN HERE THAT ARE CURRENTLY 9 

OVERCROWDED THAT COME TO WORK IN YOUR CITIES ALL OF WHICH 10 

CAN'T DO REMOTE WORK, WORKING IN YOUR GROCERY STORES, IN YOUR 11 

KITCHENS, AND THE REALITY IS, THEY HAVE TO KEEP ON COMMUTING 12 

INTO THE BAY AREA BECAUSE OF A FAILURE TO BUILD WITHIN THERE. 13 

AND THIS IS EVEN PREPANDEMIC HAS BEEN A PROBLEM. LIKE, THAT 14 

CROWDING IS GOING TO CAUSE FURTHER CORONAVIRUS SPREAD. NOT 15 

DENSITY. THIS IS ABOUT CROWDING. PEOPLE CURRENTLY TAKING OVER 16 

-- THEY HAVE ONE SINGLE FAMILY HOME. THERE WILL BE EIGHT 17 

PEOPLE LIVING IN IT OR MORE WHEN WE COULD BE BUILDING ENOUGH 18 

APARTMENTS OR CONDOS OR TOWNHOUSES OR WHATEVER, CLOSE TO WHERE 19 

YOU ARE NOW AND NOT CREATING ADDITIONAL TRAFFIC ON THE ROAD 20 

AND BUILDING INCLUSIVE COMMUNITIES THAT COULD INCLUDE THEM. 21 

YOU HAVE TO START THINKING ABOUT THEM OUTSIDE OF THIS LENS 22 

WITHOUT LOOKING AT HOW WE, YOU KNOW, THE PEOPLE THAT ARE 23 

PRIVILEGED ENOUGH TO BE ABLE TO MAKE THESE CALLS, YOU NEED TO 24 

THINK ABOUT THE REST OF OUR COMMUNITIES THAT SUPPORT US AND 25 



July 16, 2020 

 63 

THINK ABOUT HOW CAN WE BRING THEM IN HOW CAN WE BUILD ENOUGH 1 

HOUSING FOR THEM.  2 

 3 

KAREN MITCHOFF, CHAIR: OKAY. THANK YOU VERY MUCH. CARLOS, GO 4 

AHEAD.  5 

 6 

CARLOS ROMERO: THANK YOU FOR BEING SO GENEROUS WITH ALLOWS US 7 

TO SPEAK. I'LL MAKE THIS A QUICK COMMENT BECAUSE I HAVE 8 

COMMENTED IN THE PAST. SPECIFICALLY IN TERMS OF THE NUMBER OF 9 

UNITS WE SHOULD BE PLANNING FOR, CLEARLY WE'RE LOOKING AT THAT 10 

WITH RHNA BUT ALSO WITHIN THIS PLAN, WE HAVE A GOAL. WE SHOULD 11 

ALL KEEP IN MIND THAT THIS IS ESSENTIALLY A FIVE YEAR PLAN 12 

THAT WE WORK ON EVERY FOUR YEARS. IT MOVES US IN THE RIGHT 13 

DIRECTION. AS MUCH AS I WOULD LIKE TO SEE MORE HOUSING, 14 

CERTAINLY, PRIORITIZED, AND PUT IN THE PLAN, THERE IS THE 15 

PROBLEM OF SB35, IN WHICH IF WE DON'T GET THE APPROPRIATE 16 

NUMBER OF MARKET RATE UNITS PRODUCED, THE CITIES WILL THEN 17 

HAVE TO ISSUE BY RIGHT PERMITS FOR THOSE CITIES WHERE INDEED 18 

THE MARKET RATE HOUSING IS NOT BEING PRODUCED AT THE 19 

APPROPRIATE LEVEL. MARKET INDEED MAY NOT BE ABLE TO 20 

ACCOMMODATE SIGNIFICANTLY HIGHER NUMBERS. THIS IS A FIVE YEAR 21 

PLAN. SO I THINK THERE IS ALLOWANCE IN THE GOAL THAT WE'RE 22 

SETTING TO BE REALISTIC ENOUGH THAT IF WE CALIBRATE, WE CAN 23 

CALIBRATE IN THE FUTURE. A LOT OF BY RIGHT HOUSING IN WHICH 24 

THE LOCAL COMMUNITIES DON'T HAVE OPPORTUNITY TO MEET STANDARDS 25 
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APPLIED THERE COULD BE REPERCUSSIONS TO TRY TO OVERTURN SOME 1 

OF THE LAWS THAT WE PRESENTLY HAVE. IS LASTLY I WANT TO SAY 2 

THE PLAN ITSELF IS CALLING FOR STRATEGIES AROUND 10 TO 20 3 

PERCENT OF AFFORDABLE HOUSING. I KNOW THERE HAS BEEN TALK 4 

ABOUT MIDDLE INCOME HOUSING. I THINK WE SHOULD CONSIDER 5 

INCREASING THAT NUMBER TO 15 TO 25 PERCENT, AND INDEED THE 6 

HIGHER PORTION, LET'S SAY BETWEEN THE 20 TO 25, A FIVE PERCENT 7 

PORTION COULD INDEED BE DEDICATED TO THE "MISSING MIDDLE" OR 8 

MIDDLE INCOME HOUSING THAT HOUSING IS EASIER TO BUILD AND 9 

REQUIRED FAR LESS SUBSIDIES THAN THE LOWER INCOME HOUSING THAT 10 

CLEARLY IS NEEDED TO MAKE SURE THAT COMMUNITIES OF COLOR AND 11 

WORKING CLASS FOLKS ARE NOT DISPLACED FROM THE COMMUNITIES. 12 

THANK YOU MADAM CHAIR.  13 

 14 

KAREN MITCHOFF, CHAIR: THANK YOU. MARK ROSS PLEASE.  15 

 16 

DIR. MARK ROSS: THANK YOU MADAM CHAIR. I'LL BE QUICK. I HAVE 17 

SPOKEN BEFORE ABOUT TAX POLICY. I THINK IT'S A SHORT CUT TO 18 

PROVIDING SOME HOUSING, NUMBER ONE CUT OR ALTER CAPITAL GAINS. 19 

A LOT OF PEOPLE WILL SELL. RETIRED PEOPLE WILL SELL THEIR 20 

RENTALS AND MANY PEOPLE HAVE CREATED -- BUT THEY DO NOT SELL 21 

DUE TO CAPITAL GAINS STATE AND FEDERAL YOU COULD COMPARE THAT 22 

WITH AN ALTERED 1031 EXCHANGE WHICH SOME PEOPLE USE TO GET TAX 23 

CREDIT OR JUST TO RELINQUISH HOUSING THEY HAVE. YOU COULD GET 24 

TAX CREDITS FOR HUGE INCENTIVES THROUGH TAX CREDITS TO BUILD 25 
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HOUSING AND ONCE IT'S BUILT YOU COULD CONSIDER A REVERSE 1 

WILLIAM SON ACT. SO IT WOULD HAVE A TAX SHELTER FOR 5, 10 2 

YEARS. THOSE ARE MY THOUGHTS. THANK YOU VERY MUCH FOR YOUR 3 

HARD WORK.  4 

 5 

KAREN MITCHOFF, CHAIR: THANK YOU. I WANT TO CHECK. I HAVE GOT 6 

A CHAT HERE. I WANT TO SURE WE HAVE ANSWERED EVERYBODY -- IF 7 

DEMAND IT LOW IT DOESN'T MATTER IF HOUSING IS BY RIGHT. OKAY. 8 

THANK YOU VERY MUCH. ANY OTHER COMMENTS RECEIVED FRED?  9 

 10 

CLERK OF THE BOARD: I DO NOT SEE ANY FURTHER PUBLIC COMMENTS. 11 

OF THE SONJA TRAUSS HAS HER HAND RAISED.  12 

 13 

KAREN MITCHOFF, CHAIR: GO AHEAD.  14 

 15 

SPEAKER: THIS IS GOING TO BE HELPFUL. SITUATION IS LIKE ANY 16 

TOWN IN BAY AREA THEY HAVE TO BUILT HOUSING UNITS BUT NOBODY 17 

WANTS TO BUILD HOUSING UNITs BUT THERE IS NO DEMAND BUT CARLOS 18 

SAYS IF WE DON'T BUILD UNITS ZONING HAS TO BE BY RIGHT. IF 19 

NUMBER'S MAKING APPLICATIONS THE REASON THINGS ARE BY RIGHT IS 20 

ALSO THE REASON THAT IT DOESN'T MATTER IF YOU HAVE TO GO -- IF 21 

YOU HAVE TO LET PEOPLE USE THE SB35 -- DOES THAT MAKE SENSE? 22 

THE ONLY WAY YOU'RE GOING TO GET INTO A SITUATION WHERE A LOW 23 

ECONOMY, A SLOW ECONOMY MEANS THAT YOU HAVE -- THAT SB35 KICKS 24 
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IN THERE IS ALSO A TIME WHEN SB35 KICKS IN IT DOESN'T MATTER 1 

BECAUSE NO ONE IS TRYING TO BUILD ANYTHING ANYWAY.  2 

 3 

KAREN MITCHOFF, CHAIR: THANK YOU SONJA. THAT'S A COMMENT. AND 4 

WE DO NOT HAVE TIME FOR ANY FURTHER DISCUSSION. I'M GOING MOVE 5 

ON. THEY CAN HAVE THAT CONVERSATION IN THE CHAT. ITEM 5B 6 

PLANNED BAY AREA 2050 ADDITIONAL PRIORITY DEVELOPMENT AREAS 7 

SUBMITTED FOR FINAL BLUEPRINT THIS IS ALSO AN INFORMATION 8 

ITEM. MR. SHORETT AHEAD PLEASE.  9 

 10 

MARK SHORETT: THANK YOU. I WILL KEEP THIS BRIEF. THIS ITEM 11 

DOES NOT INCLUDE A POWERPOINT.  12 

 13 

KAREN MITCHOFF, CHAIR: OH NO.  14 

 15 

MARK SHORETT: THIS EVENING THE ABAG EXECUTIVE BOARD WILL 16 

CONSIDER THE ADMINISTRATIVE COMMITTEE'S RECOMMENDATION THAT IT 17 

ADOPT FOUR NEW PDAS COMPLIMENTED BY BOUNDARY CHANGES OF 18 

ADDITIONAL PDAS THIS IS LOCALLY NOMINATED PDA IN FEBRUARY. IN 19 

ADDITION EXISTING PDAS AND SELECT GROWTH GEOGRAPHIES OUTSIDE 20 

PDAS THIS SET WAS INTEGRATED INTO THE PLANNED BAY AREA 2050 21 

DRAFT BLUEPRINT WHICH DAVE TALKED TO YOU ABOUT EARLIER TODAY 22 

IN CONCERT WITH ADOPTION OF THESE PDAS EXECUTIVE BOARD 23 

RECOMMENDED STAFF PROVIDE ADDITIONAL OPPORTUNITY FOR 24 

JURISDICTION TO NOMINATE OR MODIFY PDAS PRIOR TO THE PLANNED 25 
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BAY AREA 2050 BLUEPRINT. WINDOW TO DO THIS CLOSED IN LATE MAY. 1 

SO DURING EXTENSIVE ENGAGEMENT WITH LOCAL STAFF WE HEARD FROM 2 

MOST OF THEM THEY CAREFULLY CONSIDERED OPPORTUNITIES TO CREATE 3 

NEW PDAS DURING THE SUBMISSION PROCESS REFLECTED IN THE 4 

FEBRUARY ADOPTIONS CITIES SUBMITTED FOUR NEW PDAS EACH 5 

SUPPORTED BY CITY COUNCIL RESOLUTIONS AND CONSISTENT WITH 6 

CRITERIA SET BY ABAG BOARD IN 2019 WHEN IT DID AN ADOPTION 7 

THAT UPDATED THE REGIONAL GROWTH FRAMEWORK. SO THIS INCLUDES 8 

TWO PDAS IN THE CITY OF SAN RAFAEL AND ONE EACH IN BENICIA AND 9 

FAIRFIELD IN ADDITION WE RECEIVED FIVE PROPOSED BOUNDARY PDAS 10 

TWO IN SAN JOSE FAIR FEEL AND ONE FROM LIVERMORE. SO PENDING 11 

EXECUTIVE BOARD ACTION THIS EVENING, THESE NEW AND MODIFIED 12 

PDAS WILL BE INTEGRATED INTO THE PLANNED BAY AREA 2050 FINAL 13 

BLUEPRINT AND I'LL CLOSE THERE IF THERE IS ANY QUESTIONS.  14 

 15 

KAREN MITCHOFF, CHAIR: ALL RIGHT. LET'S TAKE A LOOK AND SEE. I 16 

DON'T SEE ANY HANDS RAISED. IS THERE ANY MEMBER OF THE PROBLEM 17 

THAT WISHES TO COMMENT, FRED?  18 

 19 

CLERK OF THE BOARD: NO MEMBERS OF THE PUBLIC WITH THEIR HAND 20 

RAISED NOW. EXCEPT NOW, THERE IS ONE.  21 

 22 

KAREN MITCHOFF, CHAIR: LET'S GO TO THAT PERSON.  23 

 24 

CLERK OF THE BOARD: RODNEY NICKENS, GO AHEAD. RODNEY?  25 
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 1 

KAREN MITCHOFF, CHAIR: LET'S GO ON TO THE NEXT SPEAKER. OR 2 

THERE ISN'T A NEXT SPEAKER. CORRECT.  3 

 4 

SPEAKER: I AM HERE. SORRY ABOUT THAT.  5 

 6 

KAREN MITCHOFF, CHAIR: NO PROBLEM.  7 

 8 

SPEAKER: GOOD AFTERNOON. RODNEY NICKENS WITH THE NON-PROFIT 9 

HOUSING ASSOCIATION AGAIN. I'LL BE BRIEF. JUST WANTED TO THANK 10 

STAFF FOR THEIR WORK ON INTEGRATING PLANNED GEOGRAPHIES INTO 11 

THE BLUEPRINT AND AS WELL AS EXPANDING THOSE INTO PRIORITY 12 

DEVELOPMENT AREAS I ALSO WANT TO THANK STAFF FOR REACHING OUT 13 

AND INCLUDING ME ON THE TECHNICAL ADVISORY COMMITTEE. I AM 14 

EAGER TO EXPLORE WAYS TO IMPROVE THESE PROGRAMS AND TO 15 

ESTABLISH HIGHER STANDARDS AS WELL AS AFFORDABILITY THRESHOLDS 16 

AND LOOK FORWARD TO DISCUSSING AND COLLABORATING WITH STAFF ON 17 

REQUIREMENTS AND LOCAL JURISDICTION COMPLIANCE WITH HOUSING 18 

ALLOWS AND INCENTIVES FOR OUTCOMES -- PLANNING. THANK YOU.  19 

 20 

KAREN MITCHOFF, CHAIR: THANK YOU.  21 

 22 

CLERK OF THE BOARD: SPEAKER ROBERT FRUCKMAN.  23 

 24 
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SPEAKER: I WANT TO SAY I'M APPRECIATIVE OF THE SAN FRANCISCO 1 

PRIORITY DEVELOPMENT AREAS WHICH HAVE BEEN ADDED ON THE WEST 2 

SIDE OF THE CITY. I WOULD LIKE TO SEE THE ONES ON THE EAST 3 

SIDE OF THE CITY REMOVED. IN THE LAST TEN YEARS, 90 PERCENT OF 4 

AFFORDABLE HOUSING DEVELOPMENT HAS ONLY TAKEN PLACE ON THE 5 

EAST SIDE AND FORMALLY IN INDUSTRIAL AREAS WHILE THE MUCH 6 

RICHER WESTERN SIDE OF THE CITY HAS SEEN VERY LITTLE 7 

AFFORDABLE HOUSING DEVELOPMENT. IN FACT I THINK WITHIN THE 8 

LAST TEN YEARS THE RICHMOND DISTRICT WHICH IS RANKED BY THE 9 

CTC AS HAVING HIGH AND HIGHEST RESOURCE CENSUS TRACKS HAS ONLY 10 

BUILT 400 AFFORDABLE HOUSING UNITS IN THE LAST DECADE WHICH IS 11 

A THENCE AND PITTANCE AND FRANKLY EMBARRASSING. I URGE YOU TO 12 

RESTRICT PDA ACTIVITY ON THE EASTERN SIDE OF TOWN, WHICH WAS 13 

FORMERLY INDUSTRIAL SITES UNTIL 50 YEARS AGO. THANK YOU.  14 

 15 

KAREN MITCHOFF, CHAIR: THANK YOU. DO WE HAVE ANY MORE PUBLIC 16 

SPEAKERS FRED?  17 

 18 

CLERK OF THE BOARD: NO PUBLIC SPEAKERS AND NO PUBLIC COMMENTS 19 

RECEIVED BY E-MAIL.  20 

 21 

KAREN MITCHOFF, CHAIR: ALL RIGHT. THANK YOU. AND THANK YOU MR. 22 

SHORETT. LET'S GO TO ITEM SIX. OUR FAVORITE SUBJECT REGIONAL 23 

HOUSING NEEDS, MR. PAUL FASINGER.  24 

 25 
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SPEAKER: I DON'T HAVE A POWERPOINT PRESENTATION EITHER.  1 

 2 

KAREN MITCHOFF, CHAIR: WE'RE ALL GOING TO BE DISAPPOINTED THAT 3 

THERE ARE NO POWERPOINT PRESENTATIONS. I'M JOKING.  4 

 5 

SPEAKER: I'M GOING TO GIVE A QUICK DESCRIPTION OF THE ACTIONS 6 

THE EXECUTIVE BOARD TOOK JUNE 18TH WHERE IT CONSIDERED THE 7 

REGIONAL HOUSING NEEDS DETERMINATION PROVIDED BY HCD. THAT 8 

DETERMINED TOTALLED 441,176 HOUSING UNITS TO BE USED IN THE 9 

RHNA CYCLE. THOSE NUMBERS ARE NOT JUST THE TOTAL BUT DIVIDED 10 

INTO FOUR DIFFERENT INCOME CATEGORIES, VERY LOW, LOW TO 11 

MODERATE, AND ABOVE MODERATE. SO THE REQUIREMENT IS FOR 12 

HOUSING IN ALL OF THE DIFFERENT INCOME CATEGORIES. AND THOSE 13 

NUMBERS WOULD BE USED IN THE FUTURE AS THE HOUSING METHODOLOGY 14 

COMMITTEE IDENTIFIES AN ALLOCATION METHOD TO ASSIGN THOSE 15 

NUMBERS TO INDIVIDUAL JURISDICTION IN THE BAY AREA. BUT RIGHT 16 

NOW, THE HOUSING NEED IS ONLY OF THE TOTALS FOR THE REGION. 17 

LET ME SAY THAT THAT TOTAL OF 441,000 IS 135 PERCENT HIGHER 18 

THAN IN THE PREVIOUS CYCLE OF THE RHNA PROCESS. AND BY THAT, I 19 

MEAN THAT IN THE LAST RHNA CYCLE, THE TOTAL NUMBER WAS 187,990 20 

UNITS, AND NOW THIS NUMBER IS MORE THAN DOUBLE THE TOTAL 21 

NUMBER THAT WE SAW IN THE LAST RHNA CYCLE. IN PRODUCING THIS -22 

- THESE NUMBERS, HCD HAS A VERY SPECIFIC METHODOLOGY THAT IS 23 

IDENTIFIED IN STATE STATUTE IN PRODUCING THESE PARTICULAR 24 

NUMBERS HCD USED A FORECAST FROM THE DEPARTMENT OF FINANCE AND 25 
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NOT THE ABAG FORECAST USED IN THE DRAFT BLUEPRINT METHODOLOGY. 1 

THERE IS A VARIETY OF REASONS FOR THAT, BUT ESSENTIALLY, THAT 2 

IT PREFERS TO USE THAT NUMBER UNLESS WE PRODUCE A NUMBER THAT 3 

IS VERY CLOSE TO THE DEPARTMENT OF FINANCE NUMBER. CURRENTLY, 4 

THE METHODOLOGY FOR THE RHNA PROCESS ADJUSTS THAT FORECAST TO 5 

ADD FACTORS TO ADDRESS OVERPAYMENT AND OVERCROWDING IN THE 6 

REGION. AND THAT IS WHY, EVEN THOUGH THEY STARTED WITH THE 7 

DEPARTMENT OF FINANCE FORECAST, THE RHNA NUMBER, 441,000, ENDS 8 

UP BEING A NUMBER COMPARABLE TO THE ABAG BLUEPRINT -- DRAFT 9 

BLUEPRINT FORECAST. AND SO, AS A RESULT, THESE NUMBERS ARE 10 

SUPPORTIVE OF THE NUMBERS WE SEE IN THE DRAFT BLUEPRINT. AND 11 

THE ALLOCATION OF THOSE NUMBERS WILL BE TAKING PLACE OVER THE 12 

COMING MONTHS. THAT'S THE SUMMARY OF MY PRESENTATION. AND I 13 

WOULD BE HAPPY TO TAKE QUESTIONS IF YOU HAVE ANY.  14 

 15 

KAREN MITCHOFF, CHAIR: THANK YOU. DO WE HAVE ANY QUESTIONS? I 16 

DON'T SEE ANY HANDS RAISED. ANYBODY HAVE ANY QUESTIONS FOR 17 

PAUL? OKAY. FRED, DO WE HAVE ANY PUBLIC COMMENT?  18 

 19 

CLERK OF THE BOARD: YES. THERE ARE TWO MEMBERS OF THE PUBLIC 20 

WITH THEIR HANDS RAISED.  21 

 22 

KAREN MITCHOFF, CHAIR: GREAT. GO AHEAD PLEASE.  23 

 24 
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CLERK OF THE BOARD: FIRST SPEAKER IS RODNEY NICKENSES. GO 1 

AHEAD.  2 

 3 

SPEAKER: GOOD AFTERNOON RODNEY NICKENS NON-PROFIT HOUSING 4 

ASSOCIATION. ALSO A NUMBER OF YIMBY. I WANT TO MAKE PINT TO 5 

RECOGNIZE THE RHNA NUMBER IS LOWER THAN IT HAS BEEN IN THE 6 

PAST. THIS IS A MOMENT TO RISE TO THE OCCASION AND ADDRESS THE 7 

LACK OF PLANNING THAT HAS LEAD US TO THE SITUATION WE'RE 8 

CURRENTLY IN. I WOULD LIKE TO ASK STAFF AND THIS BODY TO 9 

PARTNER WITH US, AND THE AFFORDABLE HOUSING ADVOCACY COMMUNITY 10 

TO CONTINUE TO ADDRESS THESE CHALLENGES AND RISE TO THE 11 

OCCASION. THANK YOU.  12 

 13 

KAREN MITCHOFF, CHAIR: THANK YOU. RODNEY. ANYBODY ELSE FRED?  14 

 15 

CLERK OF THE BOARD: KYLE KELLY.  16 

 17 

SPEAKER: I AM CURIOUS IF THERE HAS BEEN A RETROSPECTIVE DONE 18 

TO DETERMINE WHAT THE REGIONAL HOUSING NEEDS ALLOCATION HAS 19 

BEEN IN THE PAST. TO SEE IF IT HAS BEEN ENOUGH HOUSING FOR 20 

EVERYBODY WHO HAD HOMELESS OR CURRENTLY IN OVERCROWDING 21 

SITUATIONS. TO DETERMINE IF THE 400 K IS AN APPROPRIATE 22 

AMOUNT.  23 

 24 
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CLERK OF THE BOARD: THANK YOU. LAST SPEAKER IS ADAM 1 

BUCKBINDER. GO AHEAD.  2 

 3 

KAREN MITCHOFF, CHAIR: ARE YOU TRYING TO UNMUTE YOURSELF, MR. 4 

BUCKBINDER? HELLO? IF YOU CAN'T HEAR US, UNFORTUNATELY WE 5 

CAN'T HEAR YOU. I ENCOURAGE YOU TO SUBMIT YOUR PUBLIC COMMENT 6 

TO MR. CASTRO IN WRITING AND HE'LL MAKE SURE WE ALL GET A COPY 7 

OF IT. OKAY. WITH THAT I'M NOT SEEING ANY OTHER BUSINESS. 8 

LET'S SEE. WE'RE ADJOURNING UNTIL OUR NEXT MEETING ON 9 

WEDNESDAY SEPTEMBER 2ND, 2020. SO WITH THAT I'M GOING TO 10 

ADJOURN THE MEETING. THANK YOU STAFF FOR ALL OF YOUR HARD 11 

WORK, AS ALWAYS, AND THANK ALL OF MY COLLEAGUES ON THIS 12 

COMMITTEE FOR TAKING TIME. I KNOW HOW BUSY WE ALL ARE. HAVE A 13 

GOOD REST OF THE DAY. WE WILL SEE YOU AT ONE OF THE MANY 14 

MEETINGS THAT'S GOING TO CONTINUE ON LATER ON THIS AFTERNOON 15 

AND THIS EVENING. GO GET SOMETHING TO EAT. [LAUGHTER] BYE-BYE. 16 

[ADJOURNED]  17 

 18 


